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Dialog Editor

The following topics are covered below:

General Information

The Dialog Editor Window

Editing Dialogs

Dialog Wizard

Creating Dialog Elements

Importing Data Fields

Editing Dialog Elements

Organizing An Application’s Help File
Setting Editor Options

Attributes Windows for Dialogs and Dialog Elements
Dialog Boxes

See also:

e Dialog Editor Accelerators

General Information

A single dialog is not only an isolated Natural object like a map or a program but can also represent an entire
event-driven application. The dialog editor can be used to create an application with the following basic components:

Dialog(s)

Dialog elements

Attributes

Event handlers

Data areas (local and parameter); global data areas can be referenced
Inline subroutines

For a reference description of dialogs, dialog elements, attributes and event handlerfiséagti@®mponents
documentation

For an overview of dialog editor terminology, $e&oduction to Event-Driven Programming

You can open a new dialog editor window from the Natural base window by choosing "Object > New > Dialog".
Alternatively, you can edit an existing dialog by selecting it from the "Library Workspace" window.

Menus, toolbar buttons, and commands available with the dialog editor can be used to create the components of an
event-driven application and edit them in various editor windows. You can create or edit another dialog, or invoke a
different editor and create or edit a different type of object (for example, program, DDM or data area).
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Dialog Editor Window

Changing the Initial Position of the Dialog
Changing the Initial Size of the Dialog
Selecting/Deselecting Dialog Elements
Aborting Mouse Operations

Creation Mode in Map Editor and Dialog Editor
Changing the Position of a Dialog Element
Changing the Size of a Dialog Element

Moving the Pointer

Simulating the Mouse with the Spacebar
Opening Windows and Dialog Boxes Using The Keyboard
Scrolling in a Dialog

Using the Clipboard

The dialog editor window includes a title bar, an information bar below the title bar, and a status line.

The title bar includes the name of the dialog (or "Untitled" if the dialog and the library have not been named). For
example:

MYDIALOG [MYLIB] - Dialog

The information bar below the title bar contains the following information:

ltem Explanation

Status Indicates whether the dialog has been modified since it was saved.

Indicates the handle name of the currently selected dialog element; the selection box displayd the
handle names of all dialog elements in the dialog together with their level number in the dialog
element hierarchy. You can select another dialog element in the selection box.

Selected
(handle)

X axis position of the currently selected dialog element relative to the upper left corner of the ¢lient
X area of the parent dialog element (or dialog, for top-level dialog elements). Equivalent to the gurrent
value of the RECTANGLE-X attribute.

Y axis position of the currently selected dialog element relative to the upper left corner of the ¢lient
y area of the parent dialog element (or dialog, for top-level dialog elements). Equivalent to the gurrent
value of the RECTANGLE-Y attribute.

Width of the currently selected dialog element. Equivalent to the current value of the
RECTANGLE-W attribute.

Height of the currently selected dialog element. Equivalent to the current value of the
RECTANGLE-H attribute.

Dialogs that are larger than the area shown in the dialog editor window can be scrolled using the scroll bars on the
right and at the bottom of the dialog editor window.
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Changing the Initial Position of the Dialog

» To change the initial position of the dialog

1. Either click in its title bar and drag it to the desired location.
Or open its attributes window and type in the new coordinates (in pixels) in the "X" and "Y" fields.

» To open the attributes window

1. From the "Dialog" menu or from the dialog’'s context menu, choose "Attributes"
or select the dialog and press ENTER.

Changing the Initial Size of the Dialog

» To change the initial size of the dialog

1. Either use the sizing border of the dialog.
Or open its attributes window and type in the new size (in pixels) in the "W" and "H" fields.

Selecting/Deselecting Dialog Elements

It is possible to select multiple dialog elements, but only one can be active at any time. The active selection is
delineated by black selection marks using which the control can be resized. The inactive selection is delineated by
grey selection marks.

Dialog Editor commands which are based on a single dialog element use the active selection, whereas other (such as
'Delete’) use both the active and inactive selection. Clicking on a dialog element which is part of the inactive

selection makes it the active selection without deselecting any other dialog element.

» To select a dialog element

1. Click on an unselected dialog element, which becomes selected, while all other dialog elements become
deselected. To select an additional dialog element, hold down SHIFT and click on the dialog element. The
dialog element selected last becomes the active selection, the ones selected before are the inactive selection. To
deselect the dialog element(s), click on the blank space in the dialog window.

2. Or point to the background in the dialog window and then drag the pointer to enclose or partially enclose the
elements you want to select. To deselect or select additional elements, do the same as above while pressing
SHIFT.

. Or press TAB to select the next dialog element in the control sequence.

. Or press SHIFT+TAB to select the previous dialog element in the control sequence.

5. Or select a dialog element from the drop-down list in the status bar. You can do this by using the mouse or by
pressing F6 to switch to the drop-down list box and then using the arrow keys to select the dialog element. To
drop down the list and view the dialog elements to choose from, press F4. To deselect the drop-down list box,
press ESC or ENTER.

AW

Note:
If one or more dialog elements are already selected, you caaduitionally select other controls with the same
parent.

Aborting Mouse Operations

Any operation that is completed by releasing the left mouse button may be aborted by pressing the ESC key before
releasing the left mouse button.
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Creation Mode in Map Editor and Dialog Editor

If you create a dialog element by selecting "Insert" plus the dialog element type, the dialog editor is in "creation
mode". After creation, the dialog editor is no longer in creation mode; that is, you do not have to switch off creation
mode by clicking on the dialog element as you would in the map editor.

Changing the Position of a Dialog Element

To change the position of one or more dialog elements, select the dialog element(s). The name of the dialog element
selected first will be displayed in the status bar, together with its current position.

» To change position, you can use one of the following options:

1. Drag the dialog element to its new location using the mouse.

2. For each selected dialog element, open its attributes window and type in the new coordinates (in pixels) in the
"X"and "Y" fields.

3. Hold down SHIFT and press any arrow to move the selected dialog element(s) the number of pixels specified in
the "Tools Dialog Editor Grid Settings" dialog box.

4. Hold down SHIFT+CTRL and press any arrow to move the selected dialog element(s) by one pixel.

Changing the Size of a Dialog Element

» To change the size of one or more dialog elements, select the dialog element(s). You then have the following
options:

1. Point to one of the eight small black squares (the selection mark of the last selected dialog element). The mouse
pointer now indicates the direction into which you can resize the dialog element. Hold down the left mouse
button and drag (one of) the dialog element(s) to the desired size. If more than one dialog element is selected,
the other dialog elements selected are resized proportionally.

2. Open the dialog element’s attributes window and type in the new size (in pixels) in the "W" and "H" fields.

3. Choose "Control > Stretch”, then the direction into which you can resize the dialog element. Then use the
mouse or the keyboard to continue the operation.

Moving the Pointer

» To move the pointer, you have three options:

1. Move the mouse; or

2. Press any arrow key to move the pointer by the number of pixels specified in the "Options Dialog Editor Grid
Settings" dialog box; or

3. Hold down CTRL and press any arrow key to move the pointer by one pixel.
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Simulating the Mouse with the Spacebar

Simulating the Mouse with the Spacebar

You can simulate mouse operations with the spacebar as described in the following table. Note that the pointer must
lie on the element to be manipulated.

Mouse Operation

Keyboard Operation

Press left mouse
button

Press and hold down the spacebar.

Release left mouse
button

Release the spacebar.

Click mouse

Press and release the spacebar.

Double-click mouse

Press and release the spacebar twice.

Move dialog element

Move pointer to element, press and hold down the spacebar, press the appropriate
key(s).

arrow

Select several dialog
elements

Move pointer to background, press and hold down the spacebar, press the appropr
arrow key(s).

ate

Resize dialog elemen

Move pointer to any black square of selected element, press and hold down the sp3

\cebar,

press the appropriate arrow key(s), release the spacebar.

Simulating a mouse double-click with the spacebar opens the attributes window for the dialog element on which the
pointer is positioned; if the pointer is not positioned on any dialog element, the dialog attributes window is opened.
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Opening Windows and Dialog Boxes Using The Keyboard

Key
(Combination)

Opens

ENTER

Attributes window of the selected dialog element or of the dialog, if no dialog element s
selected.

CTRL+ALT+E

"Event Handlers" dialog box for the dialog.

CTRL+SHIFT+E

"Event Handlers" dialog box for the selected dialog element.

SHIFT+ENTER

"Event Handlers" dialog box for the selected dialog element or for the dialog, if no dialpg
element is selected.

CTRL+ALT+S The dialog’s "Subroutines" dialog box.
CTRL+ALT+M Menu bar attributes window.

CTRL+ALT+T Toolbar attributes window.

CTRL+ALT+I Timer attributes window.

CTRL+ALT+L The dialog’s "Local Data Area" dialog box.
CTRL+ALT+P The dialog’s "Parameter Data Area" dialog box.
CTRL+ALT+G The dialog’s "Global Data Area" dialog box.

Scrolling in a Dialog

You can scroll in a dialog window if at least one dialog element is outside its scroll range. For you to be able to

scroll in a dialog, the dialog scroll bars must be active. To activate the dialog scroll bars, open the dialog attributes
window either by pressing ENTER or by double-clicking in the dialog. Then click either the "Horizontal Scrollbar"

or "Vertical Scrollbar" entry.

» To scroll with the mouse, you either:

1. Point to the scroll-bar slider and drag the slider in the desired direction; or
2. Point to the scroll-bar shaft and click; or
3. Point to one of the scroll-bar arrow buttons and hold down the left mouse button.

To scroll with the keyboard, you do not need a scroll bar. You have four options:

1. To simulate clicking into a vertical scroll bar, press the PAGE UP or PAGE DOWN keys; or
2. To simulate clicking into a horizontal scroll bar, press SHIFT+PAGE UP or SHIFT+PAGE DOWN; or
3. To simulate clicking on the corresponding vertical arrow button, press CTRL+PAGE UP or CTRL+PAGE

DOWN; or

4. To simulate clicking on the corresponding horizontal arrow button, press CTRL+SHIFT+PAGE UP or
CTRL+SHIFT+PAGE DOWN.

Using the Clipboard

Key (Combination)

Function

DEL

Delete the selected dialog element

CTRL+C Copy
CTRL+V Paste
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Editing Dialogs

Editing a Dialog’s Source Code

Editing a Dialog’s Attributes

Editing a Dialog’s Event Handlers

Defining a Dialog’s Menu Bar

Defining a Dialog’s Toolbar

Creating and Maintaining Timers for a Dialog
Adding a Comment Section to a Dialog
Defining a Parameter or Local Data Area for a Dialog
Selecting a Global Data Area for a Dialog
Defining an Inline Subroutine for a Dialog
Defining the Control Sequence in a Dialog

Editing a Dialog’s Source Code

» To edit a dialog’s source code

1.

Load the dialog into the editor.

2. From the "Dialog" menu, choose "Source Code...".

Or press CTRL+ALT+C.

The dialog’s source code window appears and the program editor is loaded. This editor enables you to scan for
text strings, replace them, and so on. For more information on how to use the program editer Fregram

Editor.

You can switch between the dialog editor and the program editor by selecting the source code window or the
dialog window. If you edit in either window, you need to synchronize your updates: (graphically) modifying the
dialog locks the source code window and you may not make changes there. Correspondingly, if you change the
source code, you may not make changes in the dialog window, which is locked. If your editor is locked, its
status bar displays "Locked".

If a source code window is open, but not active, you can activate it by choosing "Source Code..." from the
"Dialog" menu.

When you issue a command from the program editor window that affects the source code, such as "Save" or
"Run”, the dialog editor updates itself automatically by scanning the source code, displaying the modified
dialog, and then regenerating the source code.When you issue a command from the dialog editor window after
you have modified the code in the source code window, you are prompted whether you want to update the
source code or not.

3. To stow any modified source code: from the program editor’s "Object" menu, choose "Stow".

Whenever you want to save a dialog under a new name, select "Save as" from the "Object" menu, where for the
"Save dialog as" dialog box appears.
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Editing a Dialog’s Attributes

» To edit a dialog’s attributes

1. Load the dialog into the editor.
2. From the "Dialog" menu or from the dialog’s context menu, choose "Attributes...".
Or double-click on the dialog.

Or press ENTER.
The dialog’s attributes window appears. To find out what the entries in the attributes window mean, choose

"Help". For context-sensitive help, select the attribute entry and press F1.
3. Enter the desired attribute values.
4. Choose OK to confirm your changes.

Editing a Dialog’s Event Handlers

» To edit a dialog’s event handlers

1. Load the dialog into the editor.

2. From the "Dialog" menu or from the dialog’s context menu, choose "Event handlers...".
Or press CTRL+ALT+E or SHIFT+ENTER.
The dialog’s event handler section appears.

3. Select the type of event (such as BEFORE-OPEN or ERROR).
Or choose "New" to enter a user-defined event.
Or choose "Rename" to save a user-defined event with a new name.

4. Enter the desired event code in free form either in the edit window in the "Dialog Event Handler"window itself,
or using the Program Editor. To use the Program Editor, click the "Editor" push button, then close the "Dialog
Event Handler" window using the "OK" push button. This code will be executed when the event occurs for the

dialog. Note that if you have specified code in the before-any and after-any event sections, this will be triggered

before and after the code entered here. So if you need common event code, you only have to enter it once in

your dialog’s before-any and after-any event section.
5. Choose OK to save your code, if using the "Dialog Event Handler" window. If using the Program Editor, the
code can be saved by choosing "Save" from the "Object" menu, or by closing the Program Editor and electing

to save the changes when prompted.
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Defining a Dialog’s Menu Bar

» To define a dialog’s menu bar

1. Load the dialog into the editor.
2. From the "Dialog" menu, choose "Menu bar...".

Or press CTRL+ALT+M.
A dialog box appears asking you whether you want to turn the dialog’s menu bar setting on.

3. Choose "Yes".
A blank default menu bar is added to the dialog and the menu bar’s attributes window appears. For more

information on the attributes window, see the sediiemu Editor Window
4. Choose OK to confirm your changes.

Defining a Dialog’s Toolbar

» To define a dialog’s toolbar

1. Load the dialog into the editor.
2. From the "Dialog" menu, choose "Toolbar...".
Or press CTRL+ALT+T.
A dialog box appears asking you whether you want to turn the dialog’s toolbar setting on.

3. Choose "Yes".
A blank default toolbar is added to the dialog and the toolbar’s attributes window appears. For more information
on the attributes window, see the secfi@aolbar Control Attributes Windown this section you will also find

information on new toolbar control features.
4. Choose OK to confirm your changes.

Creating and Maintaining Timers for a Dialog

You use timers to trigger a dialog event periodically.

» To create and maintain a timer for a dialog

1. Load the dialog into the editor.
2. From the "Dialog" menu, choose "Timers...".

Or press CTRL+ALTHI.
The timer’s attributes window appears. For more information on the attributes window, see theTseetion

Attributes Window
3. Choose OK to confirm your changes.
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Adding a Comment Section to a Dialog

» To add a comment section to a dialog

1. From the "Dialog" menu, choose "Dialog comment...".

Or press CTRL+ALT+O.
The dialog comment section appears where you can enter your comments in free form. Please note that you do

not have to use the "/*" notation when entering comments in the text area. If you are listing your dialog code,

you will find your comment at the beginning.
2. Choose OK to save your comment.

Defining a Parameter or Local Data Area for a Dialog

» To define a local data area for a dialog

1. From the "Dialog" menu or from the dialog’'s context menu, choose "Local Data Area...".

Or press CTRL+ALT+L.
The definition section for the local data area appears. In a local data area, you must include all the user-defined

variables or other variables that you want to use in an event handler code section or a subroutine of the current
dialog. Note that the dialog editor automatically generates the data definitions for the dialog elements.
The "Using" button opens a dialog box that enables you to include existing inline data definitions.

2. Choose OK to save your data definition.

» To define a parameter data area for a dialog

1. From the "Dialog" menu, choose "Parameter Data Area...".

Or press CTRL+ALT+P.
The definition section for the parameter data area appears. In a parameter data area, you must include all the

parameters that you want to be passed on to the current dialog in an OPEN DIALOG or SEND EVENT

statement.
The "Using" button opens a dialog box that enables you to include existing inline data definitions.

2. Choose OK to save your data definition.
Selecting a Global Data Area for a Dialog

» To select a global data area for a dialog

1. From the "Dialog" menu, choose "Global Data Area...".

Or press CTRL+ALT+G.
A dialog box appears where you can select a global data area for the dialog.

2. Select an entry in the "Available Global Data Areas" list box.
3. Choose OK.
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Defining an Inline Subroutine for a Dialog

» To define an inline subroutine for a dialog

1. Load the dialog into the editor.

2. From the "Dialog" menu or from the dialog’s context menu, choose "Inline Subroutines...".
Or press CTRL+ALT+S.
The "Dialog inline subroutines” code section appears.

3. Choose "New" to enter a new subroutine.
Or select the name of an existing subroutine you want to edit.
If you have chosen "New", a dialog box prompts you for a name.

4. Enter the name of the new subroutine.

5. Choose OK.

6. Enter the desired subroutine code in free form, either directly in the window itself or using the Program Editor
by clicking the 'Editor’ push button, then close the window using the’OK’ push button.

7. Choose OK to save your code.

Defining the Control Sequence in a Dialog

The control sequence is the keyboard navigation sequence in which the end user will go through the dialog elements.

» To define the control sequence of a dialog

1. From the "Dialog" menu, choose "Control sequence”, or press CTRL+ALT+Q
The control sequence is displayed as a number at the top left corner of each dialog element. The editor is now in
navigation sequence definition mode.

2. Use the mouse to select the dialog elements in the desired sequence.

If you do notselect a dialog element before enabling navigation sequence definition mode, the next dialog element
that you select will be the first in the navigation sequence. Its number is greyed and you can select the next dialog
element in the sequence, and so on.

If you do select a dialog element, you can redefine the sequence from this element onwards.You can also select a
dialog element when in control sequence editing nwaitteout resequencing it by holding down the SHIFT key

whilst making the selection. This is especially useful if the selected dialog element is one of the last elements in the
sequence - you do not have to redefine the sequence of all preceding dialog elements. Note that instead of selecting
each dialog element with the mouse, you can also select them from the selection box in the status bar of the dialog
editor. This selection box always shows the dialog elements in their control sequence.

You can exit control sequence editing mode implicitly, by selecting another command (e.qg. 'Insert Push Button’) or
explicitly by selecting the 'control sequence’ menu of this again, or simply by pressing ESC.

Note:
The control sequence also decides the order in which the dialog elements overlap.

Dialog Wizard

The Dialog Wizard is a tool for creating dialogs for specific purposes. The defined dialogs can have several layouts
that adapt to desired requirements.

The generated dialog can be modified with the dialog editor. In the dialog there are User Code Sections with sample
coding for data retrieval and result flagging. These sections should be replaced by user-specific requirements.
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» To activate the Wizard:

@ Hew [using Wizard)

Frame Selection Tab Dialog
Diialog Diialog

— Prewisw

Mo Preview available

s [

e From the "Menu Bar" select "Object" > "New" > "Dialog Wizard".

Frame Dialog

In the Frame Dialog Wizard a new dialog can be created in a Frame Layout. The structure of the Frame Dialog for
example is applicable in an application frame.

A default Frame Dialog is generated if you define nothing in the wizard.
Selection Dialog

In the Selection Dialog Wizard a new dialog can be created in a Selection Layout. The structure of a Selection
Dialog for example is applicable for reading, saving or opening objects.

A default Selection Dialog is generated if you define nothing in the wizard.
Tab Dialog

In the Tab Dialog Wizard a new dialog can be created in a Tab Layout. The structure of a Tab Dialog for example is
applicable in a help dialog or for option settings.

A default Tab Dialog is generated if you define nothing in the wizard.
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Creating Dialog Elements

» To create a dialog element

1. From the "Insert" menu, choose one of the following entries, depending on which dialog element type you wish
to create:
"ActiveX control","Bitmap"”, "Canvas", "Control Box", "Edit area", "Group frame", "Input field", "List box",
"OLE container", "Push button", "Radio button", "Scroll bar", "Selection box", "Table", "Text constant",
"Toggle button".
After one of these items has been selected, you are in creation mode. If you move the mouse within the dialog
window, the cursor shape is a cross with a minimized graphical representation of the dialog element to be
created.

2. Move the cursor to the desired upper left position of the dialog element.

3. Either hold down the left mouse button, drag the cursor until you have created the desired outline of the new
dialog element and release the mouse button.
Or click or press ENTER.
This creates a dialog element with a default size.

The control sequence is the keyboard navigation sequence in which the end user will go through the dialog elements.
It is decided by the order in which you create the dialog elements. When you create a new dialog element, it is
inserted after the active selection and any of its successive direct and indirect children if the active selection shares
the same parent as the newly-inserted control. If not, the insertion point is based on the last dialog element with the
same parent whicprecedes the active selection in the control sequence. If there is no such control, or if no controls
are selected, the new control is inserted immediately before the first control with the same parent, or immediately
after its container if no such control exists. You can modify this default sequence by choosing "Dialog > Control
Sequence". For more information, see the se@igfining the Control Sequence in a Dialog

Note:
The same rules apply to dialog elements created by pasting them from the clipboard.

If you insert a new dialog element dynamically by using the PROCESS GUI statement action ADD, you decide its
position in the navigation sequence by creating the dialog element and setting the SUCCESSOR attribute to the
handle value of its successor.
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Importing Data Fields

You can import a data field from an object in your Natural environment into an input field control or a selection box
control which you create at the same time.

» To import data fields

1. From the "Insert" menu, choose "Import".

2. From the "Import" submenu, choose "Input field" or "Selection box".
The "Import Data Field" dialog box appears.

3. Enter the library and the Natural object type.
A list of objects appears.

4. Choose an object.

A list of data fields appears.
5. Choose the data field(s) you want to use for creating a dialog element.

6. Choose "Import".
The selection box control or the input field control is created with the selected data field(s). Note that the fields
themselves are not imported.
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Editing Dialog Elements

Cutting a Dialog Element

Copying a Dialog Element

Pasting a Dialog Element from the Clipboard

Deleting a Dialog Element

Selecting all Dialog Elements with the same Parent in a Dialog
Editing a Dialog Element’s Attributes

Editing a Dialog Element’s Event Handlers

Unifying the Size of Several Dialog Elements

Aligning the Position of Several Dialog Elements
Unifying the Spacing Between Several Dialog Elements
Stretching a Dialog Element

To edit one or several dialog elements as a whole, you can use the entries provided in the "Edit menu". These entries
enable you to reuse dialog elements for similar contexts instead of creating them from scratch.

Cutting a Dialog Element

» To cut a dialog element

1. Select the dialog element.
2. From the "Edit" menu or from the dialog element’s context menu, choose "Cut".
Or click the "Cut" toolbar button.
Or press SHIFT+DEL or CTRL+X.
The selected dialog element and any of its child dialog elements is cut to the clipboard for pasting elsewhere,
for example into other dialogs.

Note:
You can also select several or all dialog elements in a dialog and cut them all at once.

Copying a Dialog Element

» To copy a dialog element

1. Select the dialog element.

2. From the "Edit" menu or from the dialog element’s context menu, choose "Copy".
Or click the "Copy" toolbar button.
Or press CTRL+INS or CTRL+C.

The selected dialog element is copied to the clipboard for pasting elsewhere. If the selected dialog element has child
dialog elements you will be prompted as to whether these should also be copied or not.

Note:
You can also select several or all dialog elements in a dialog and copy them all at once.

Pasting a Dialog Element from the Clipboard

» To paste a dialog element from the clipboard

e From the "Edit" menu or from the dialog element’s context menu, choose "Paste".
Or click the "Paste" toolbar button.
Or press SHIFT+INS or CTRL+V.
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The dialog element in the clipboard is pasted into the current container in the current dialog. The current container is
the lowest level dialog element containing the selected dialog elements which is not the selected dialog element
itself. If you are pasting a dialog element back into the same container from which it was copied, the original dialog
element is overlaid by the copy. You then have to move the pasted dialog element to its new location. (The pasted
dialog element is preselected by default.) Note that if it is desired to paste dialog elementsnmityascontainer, a

dummy child dialog element must be created and selected first.

Note:
You can paste several or all dialog elements in a dialog if you have cut or copied them to the clipboard at once.

Deleting a Dialog Element

» To delete a dialog element

1. Select the dialog element.

2. From the "Edit" menu or from the dialog element’s context menu, choose "Delete".
Or click the "Delete" toolbar button.
Or press DEL.
A dialog box appears asking you to confirm the deletion.

3. Choose "Yes".

The selected dialog element is deleted, together with any of its child dialog elements.

Note:
You can also select several or all dialog elements in a dialog and delete them all at once.

Selecting all Dialog Elements with the same Parent in a Dialog

» To select all dialog elements in a dialog

e From the "Edit" menu or from the dialog element’s context menu, choose "Select all".
If a dialog element is selected, all unselected dialog elements with the same parent become selected. If no dialog
element is selected, all top-level dialog elements become selected.
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Editing a Dialog Element’s Attributes

Editing a Dialog Element’s Attributes

» To edit a dialog element’s attributes

1.
2.

3.
4,

Ed
»

1.
2.

AW

Select the dialog element.
From the "Control" menu or from the dialog element’s context menu, choose "Attributes...".

Or double-click on the dialog element.

Or press ENTER.
The dialog element’s attributes window appears. To find out what the entries in the attributes window mean,

choose "Help". For context-sensitive help, select the attribute entry and press F1.
Enter the desired attribute values.
Choose OK to confirm your changes.

iting a Dialog Element’s Event Handlers

To edit a dialog element’s event handlers

Select the dialog element.

From the "Control" menu or from the dialog element’s context menu, choose "Event handlers...".
Or press SHIFT+ENTER.

The dialog element’s event handler section appears.

. Select the event (such as click or double-click).
. To view the event parameters of an ActiveX control, click the "Event Info..." button.
. Enter the desired event code in free form, either directly in the window itself or by using the Program Editor by

clicking the "Editor’ push button, then closing the window with the 'OK’ push button.

Or choose "Use" to enter a user-defined event.

This code will be executed when the event occurs for the dialog element. Note that if you have specified code in
the before-any and after-any event sections, this will be triggered before and after the code entered in Step 4. So
if you need common event code, you only have to enter it once in your dialog’s before-any and after-any event

section.

6. Choose OK to save your code.

Unifying the Size of Several Dialog Elements

»

1
2
3.
4
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To unify the size of several dialog elements

. Select all dialog elements whose size is to be unified.

. Select the dialog element that has the reference width or height.

From the "Control" menu, choose "Unify size".

. From the "Unify size" submenu, choose "Width".Or choose "Height".

The dialog elements are aligned to the width or height of the reference dialog element.
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Aligning the Position of Several Dialog Elements

» To align the position of several dialog elements

1. Select all dialog elements whose position is to be aligned.
2. Select the dialog element that has the reference position.
3. From the "Control" menu, choose "Align position".
4. From the "Align position" submenu, choose "Left".

Or choose "Center (horizontal)".

Or choose "Right".

Or choose "Top".

Or choose "Center (vertical)".

Or choose "Bottom".

The dialog elements are aligned to the position of the reference dialog element.

Unifying the Spacing Between Several Dialog Elements

» To unify the spacing between several dialog elements

1. Select all dialog elements between which you want to unify spacing.
2. From the "Control" menu, choose "Unify spacing".
3. From the "Unify spacing" submenu, choose "Horizontal".

Or choose "Vertical".
The spaces between the dialog elements are now distributed evenly.

Stretching a Dialog Element

» To stretch a dialog element in a particular direction

1. Select the dialog element to be stretched.
2. From the "Control" menu, choose "Stretch".
3. From the "Stretch" submenu, choose a direction, for example "North west".
A cursor appears indicating that you can stretch the dialog element.
4. Drag the cursor with the mouse until your dialog element has the desired size.
5. Click with the left mouse button to fix the dialog element’s size.
The dialog element is now resized; as it is still selected, you can edit it further.

Note:
You can also select several dialog elements and stretch them all at the same time.
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Dialog Editor Organizing An Application’s Help File

Organizing An Application’s Help File

Using The Help Organizer's Main Dialog
Generating Help IDs

Extending A Help ID Definition

Editing The Global Topic List

Help files provide online information about an application’s functions.

Whenever an end user must be given general information on how your application is structured, a help text is needed
that can be invoked from within the application.

Whenever an end user must be given specific information on what may be entered in an input field control, for
example, a short text is needed that can be accessed from the input field control.

To keep an overview of all the different help sections in an application, Natural provides you with the help organizer.
With this organizer,

® you assign a help ID (HELP-ID attribute value) to a specific dialog element;

e you write the help text for this help topic; this text is converted to a .rtf file to be processed by the help
compiler;

e you optionally define the help topic’s keywords;

® you optionally assign a help compiler macro to the help topic;

e and you optionally add a comment for your internal documentation purposes.

It is also possible to use several help files for one application. In this case, you must specify the help file in the
dialog’s attributes window. You can also use the same help file for more than one dialog.

The .rtf file and the corresponding help topic information created with the help organizer must be converted to a .hip
file. In this way, your end user can retrieve help information from the Natural application. This conversion into a .hlp
file is done with the help compiler.

The Natural installation procedure also installs a version of the Microsoft help compiler on your disk. You will find
the help compiler in a subdirectorydrive-letter\SAG\product-acronyrtversion-numbaNatural which is called
HCn wheren depends on the operating system on which Natural has been installed.

For more information on how to use the help compiler and on how to create the .hlp file from your .rtf file, please
refer to the READ.TXT file in this directory whera is depending on the operating system.

There is also an example of a small help file which was generated with the help organizer.

This example help file is called BROWHLP.HLP and is located in the directory referred to by the environment
variable NATGUI_BMP. You can find the files BROWHLP.RTF, BROWHLP.HPJ and README.TXT in the
following directory:

drive-letter\SAG\product-acronynversion-numbaNaturaN\SAMPLES\HELP\
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Organizing An Application’s Help File Dialog Editor

» To see a demonstration of the example help file

1. Goto library SYSEXEVT.
This library contains a browse application with a dialog called BROWSEL1.
2. Start the SAG-DEMO-DB database. This is a prerequisite to running the browse application.
3. Start dialog BROWSEL1 to run the application.
4. Press F1 with the focus being on various elements of the application.

» To see a demonstration of the help organizer (looking at the contents of BROWHLP.RTF)

® Follow the instructions in the README.TXT file.

» For each help topic you create, you can in general follow this sequence of steps

=

Invoke the help organizer's main dialog.
. Select a dialog element.
Generate a new help topic ID or enter the ID of your choice. To generate a help topic ID automatically, the help
ID must be "0" (default). To enter a help topic ID, either you fill in the "Help ID" entry of the dialog or dialog
element, or you fill in the help topic ID in the "Online Help Organizer" main dialog.
Return to the "Online Help Organizer" dialog.
Assign the help topic ID.
Enter the external definitions for the help topic ID, such as the help text and the topic.
Return to the "Online Help Organizer" dialog.
Go to the topic list and see whether this new help topic fits your general organization of the help file to be
created.
9. Return to the "Online Help Organizer" dialog.
10. Save everything.

w N

© NG

These steps are described in detail in the following sections.
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Dialog Editor Using The Help Organizer's Main Dialog
Using The Help Organizer’'s Main Dialog
» To invoke the "Online Help Organizer" dialog
e From the "Dialog" menu, choose "Help organizer..."
Or press CTRL+ALT+H.
The main dialog appears. It contains the following:
Entry Meaning
. Online Help Organizer pathnamglocation of the .rtf file to be generated from a help topic
Caption
text).
Help IDs in Dialog | Name of the current dialog. You organize your Help IDs dialog by dialog.
The handle name or the handle names of all dialog elements inside the dialog.
Control Name
You can not change these handle names here.
The Help ID attribute value for the dialog or dialog element. You may assign several Help ID
Helo ID values to one dialog element. If there are several Help IDs, you can view them by pulling
P down the drop-down list box. If you select a Help ID, either you can extend its definition or
you can enter a new Help ID of your choice.
. The name of the help topic. You can not edit this name here, but in the help topic’s extended
Topic - .
definition dialog box.
The help text. You can edit this text here or in the help topic’s Extended Definition dialgg
box.
Note:
Help text It is possible to enter RTF formatting commands if the help text begins with a "{\" and gnds
with a "}". This signifies "raw mode". In raw mode, special RTF characters ('{’, '} and '\
must be escaped by a preceding backslash if they are to be treated as literal characters.
However, even in raw mode, it is not necessary to enter line feed (\line) commands explicitly.
Action:
New ID Invokes the "Help ID Generation" dialog where you can generate a Help ID for those d|alogs
or dialog elements for which the Help ID is still "0" (default).
Ext Def... Invokes the "Extended Definitions - (...)" dialog.
Resets the currently selected Help ID to zero and clears the help topic text that was agsociated
Clear
to the Help ID.
Topic List Invokes the "Global Topic List" dialog.
Saves your settings, exits the dialog and generates the necessary help files. These filgs include
a "helpfilenamatf" help topic file, a helpfilenamehpj" help project file, alielpfilenamecnt”
OK contents file, alielpfilenamehm" Help ID mapping file and &élpfilenamecshelp.cnt”
contents include file.
The help project and contents files are only generated if they do not already exist, ensuiring
that any changes made directly to these files (e.g. via a text editor) are not lost.
Saves your settings and generates the help files (as for the OK pushbutton) without exjting the
Apply dialog. Allows you to save the changes and switch to and from the help compiler withopt
having to leave and re-enter the help organizer.
Cancel Exits the dialog without saving the settings.
Help Provides online help on the dialog.
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Using The Help Organizer's Main Dialog Dialog Editor

The Online Help Organizer dialog may be re-sized. The position and dimensions are saved between sessions in the
user profile (.PRU).
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Dialog Editor Generating Help IDs

Generating Help IDs

» To generate a new help topic ID

1. From the "Help Organizer Main" dialog, select a dialog or dialog element and choose the "New ID" button.
The "Help ID Generation" dialog appears.

2. (Optional) Enter a starting value which Natural will use to generate the next new ID.
This Help ID is valid only for the current dialog. To avoid duplicate Help IDs in the same Natural application,
you define exclusive numerical ranges for the help topic IDs of a dialog. The starting value enables you start off
the Help IDs at the beginning of the numerical range. You can, for example, decide that your dialog uses the
range of 50 to 60. You enter "50" as the starting base and your first generated 1D will be 50.

3. Choose OK to generate the Help ID.
Or choose "Cancel" to exit the dialog without generating.

Note:

You can also generate Help IDs for several dialogs/dialog elements at once. To do so, you must select several
dialogs/dialog elements in the "Online Help Organizer" dialog. The IDs are then generated sequentially starting from
the lowest ID available.

Extending A Help ID Definition

» To extend a help topic ID’s definition
® From the "Help Organizer Main" dialog, select a Help ID and choose the "Ext Def" button.

The "Extended Definitions" dialog appears. It contains the following:

Entry Meaning
Caption Extended Definitions -durrent HELP-IQ
Topic: Enter the heading of the help topic here.

Help Text: Enter the text of the help topic here.

Enter the keywords of your help topic here. Keywords enable the end user of your Natural

Keywords: application to find the topic by selecting the "Search" button in the "Help" window.
Browse Enter your browse sequences here. A browse sequence is useful if you want to group your help
. |topics by subject. Browse sequences can also consist of an optional alphanumeric sort key
seqguences: )
separated from the browse sequence name by a colomgesequence:sort_Key
Macro: Enter the name of your help macro here. Help macros enable you to customize your help.

Comment: | This section is for your internal help project documentation.

OK Saves your settings and exits the dialog.
Cancel Exits the dialog without saving the settings.
Help Provides online help on the dialog.

This information will be part of the .rtf file to be generated and will be interpreted by the help compiler.

The Extended Definitions dialog may be resized. The position and dimensions are saved between sessions in the user
profile (.PRU).
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Editing The Global Topic List

» To edit the global topic list
® From the "Help Organizer Main" dialog, choose the "Topic List" button.

The "Global Topic List" dialog appears. It contains the following:

Entry Meaning

Caption Global Topic List - [Fileselectedfilepath

Line in the Each line in the table represents a help topic. It lists its Help ID, the topic name and the ejtended
table definitions associated with it.

Action:

Undo Undoes the last editing action, especially deletion.

Delete If a help topic is selected, this topic is deleted.

Ext Def... Invokes the "Extended Definitions" dialog for the selected help topic.

Move Entry Allows you to change the sequence of help topic entries.

MoveUp Moves the selected help topic upwards within a browse sequence of help topic entries.

MoveDown Moves the selected help topic downwards within a browse sequence of help topic entries.

OK Saves your settings and exits the dialog.
Cancel Exits the dialog without saving the settings.
Help Provides online help on the dialog.

This list contains all of the topics in the help file. Note that the topics are always maintained in browse sequence
order.

The Global Topic List dialog may be resized. The position and dimensions are saved between sessions in the user
profile (.PRU).
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Setting Editor Options

You can set preferences for various editor options. These settings are taken as default values each time you start the
Dialog Editor.

The following options are available:

Enabling The Enhanced Listing Option

Displaying Or Hiding The Status Bar

Turning The Crosshair Cursor On And Off

Turning Autoscroll On And Off

Displaying The Dialog Inside Or Outside The Editor
Displaying Bitmaps

Displaying Or Hiding The Grid

Customizing The Grid

Saving Editor Options With A Particular Dialog

You can adapt several editor options to your personal requirements. These options regulate how the editor appears
and reacts to various types of input. For example, you can specify whether or not you want your editor window to
display a status bar.

Enabling The Enhanced Listing Option

The enhanced listing option of a dialog enables you to view the dialog source in a format that is more readable than
the traditional Natural source code. If you choose to display the code listing after receiving a compiler error, you will
get the code generated for the compiler. By default, the dialog editor enables enhanced list mode.

Note:

Enabling this option is only meaningful if you list or print "non-enhanced" dialog sources, not for the new dialog
source format. Note also that if you have saved your dialog sources in non-enhanced format and the enhanced listing
option is enabled, any Natural runtime error message will contain an incorrect line number. To ensure that you get
the correct line number, disable the enhanced listing option. As under Natural for Windows and Unix/OpenVMS
Version 4.1, dialog sources are always saved in enhanced format, this line number inconsistency does not exist, and
the older ('22C’) format is only seen if old dialogs in this format are listed or printisite of the dialog editor.

» To view the enhanced listing

e From the "Object" menu, choose "List".

» To enable enhanced dialog list mode

1. From the "Options" dialog, check the "Dialog Editor" tab.
2. Check the "Enhanced dialog list mode" toggle button.
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Displaying Or Hiding The Status Bar Dialog Editor

Displaying Or Hiding The Status Bar

By default, the dialog editor displays the status bar.

» To display or hide the status bar

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Status Bar" toggle button.

Either the toggle button now has a check mark to indicate display, or the check mark is no longer displayed to
indicate hiding.

Turning The Crosshair Cursor On And Off

By default, the dialog editor displays the system cursor. If the crosshair is turned on, and you create or move dialog
elements, lines appear that extend to the window borders.

» To display or hide the cross-hair cursor

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Crosshair" toggle button.

Either the toggle button now has a check mark to indicate display, or the check mark is no longer displayed to
indicate hiding.

Turning Autoscroll On And Off

If the toggle button is checked, the Dialog Editor window is automatically scrolled to make the dialog visible if the
dialog is moved wholly or partially outside the current visible range.

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Autoscroll" toggle button.

Either the toggle button now has a check mark to indicate display, or the check mark is no longer displayed to
indicate hiding.
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Displaying The Dialog Inside Or Outside The Editor

The dialog editor allows you to specify whether the current dialog is displayed inside the dialog editor window
(default). Displaying the dialog outside enables more space for editing. Please be careful when setting this option to
"off". Your dialog may disappear from view if its RECTANGLE-X and RECTANGLE-Y values denote a position
outside the screen. Another consequence is that the dialog will overlap any code listing window that appears.

» To display the dialog inside or outside the editor

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Display dialog inside editor" toggle button.

Either the toggle button now has a check mark to indicate display inside, or the check mark is no longer displayed to
indicate display outside.

Displaying Bitmaps

By default, the dialog editor loads and displays the bitmaps in the dialog elements to show how they appear at
runtime. If you switch this option off, the dialog element displays the bitmap name only, which improves editing
performance.

» To turn the bitmap display on or off

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Display bitmaps" toggle button.

Either the check box now has a check mark to indicate display, or the check mark is no longer displayed to indicate
unloading of bitmaps.

Displaying Or Hiding The Grid
The dialog editor enables you to display a grid to help align dialog elements. By default, the grid is not displayed.
» To display the grid

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check or uncheck the "Display Grid" toggle button.

Either the check box now has a check mark to indicate display, or the check mark is no longer displayed to indicate
hiding.
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Customizing The Grid

» To customize the grid

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Choose the "Lines" option button (which will result in a classical grid).
Or choose the "Dots" option button (which will result in a dots pattern).
3. Choose the "Color" command button.
The operating system’s "Color" dialog box is displayed.
4. Select a color.
Or define a custom color.
5. Choose OK. A sample rectangle of the chosen colour is displayed.
6. For the horizontal grid (X) axis, enter the number of pixels (steps) between two lines or dots.
7. For the x axis, enter a numerical starting value for the grid.
8. Choose the "Snap to Grid" check box if you want the dialog elements to snap to the grid.
9. Repeat Steps 7 to 9 for the y axis.
10. Choose OK to save the grid settings and return to the dialog editor.

Saving Editor Options With A Particular Dialog

The dialog editor enables you to save the option settings with the dialog in order to customize editor usage to
individual dialogs.

» To save the editor options with the current dialog

1. From the "Options" dialog, choose "Dialog Editor" tab.
2. Check the "Save settings with dialog..." check box.

The options will be saved together with the dialog itself whenever any dialog is saved. Dialogs saved whilst this
option was inactive will continue to use the current option settings.
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Attributes Windows for Dialogs and Dialog Elements

Attributes Windows for Dialogs and Dialog Elements

This section explains the editing options in the attributes windows for dialogs and dialog elements.

ActiveX Control Attributes Window
ActiveX Control Property Pages

Bitmap Control Attributes Window
Canvas Control Attributes Window
Control Box Control Attributes Window
Dialog Attributes Window

Dialog Context Menus Window

Edit Area Control Attributes Window
Group Frame Control Attributes Window
Input Field Control Attributes Window
List Box Control Attributes Window
Menu Editor Window

OLE Container Control Attributes Window
Push Button Control Attributes Window
Radio Button Control Attributes Window
Scrollbar Control Attributes Window
Selection Box Control Attributes Window
Signal Attributes Window

Status Bar Control Attributes Window
Status Bar Control Attributes Subwindow
Table Attributes Window

Text Constant Control Attributes Window
Timer Attributes Window

Toggle Button Control Attributes Window
Toolbar Attributes Window

Toolbar Control Attributes Window
Toolbar Control Attributes Subwindow

ActiveX Control Attributes Window

» Accessible Using

1.
2.
3.

Double-click on the ActiveX control; or
if selected: "Control > Attributes" or by selecting 'Attributes
if selected: ENTER.

Copyright Software AG 2002

... from the control’s context menu or

29



ActiveX Control Attributes Window

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Dialog Editor

enter here to the corresponding help topic ID (created by a markup in the .hlp file).

Entry in
Attributes Represents
Window
Name Handle name of the ActiveX control (may be overwritten with another name).
Control Name of the ActiveX control.
DIL Text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
Help ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID thgt you

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the
control.

Style:
STYLE attribute value: if the end user presses ENTER, this button is pushed. This attribu
OK Button only available for ActiveX controls that behave like buttons. These ActiveX controls are n

with the style OLEMISC_ACTSLIKEBUTTON in the system registry.

te is
arked

Cancel Button

STYLE attribute value: if the end user presses ESC, this button is pushed. This attribute i
available for ActiveX controls that behave like buttons. These ActiveX controls are marke
the style OLEMISC_ACTSLIKEBUTTON in the system registry.

S only
i with

Ind its

State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
The following four attributes decide the ActiveX control’s x and y axis position, its height
width on the screen.
Rectanale: X - RECTANGLE-X attribute value.
meclangle: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
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ActiveX Control Attributes Window

Entry in
Attributes Represents
Window
Displays a dialog box for editing the properties provided with the selected ActiveX control. To
enable editing a property, select it from the "Properties"” list box.
Only simple properties are displayed in this list box. Other properties (for example paramgterized
properties) can be configured using the ActiveX control’s property pageédceeX Control
Property Pages
The current value of the selected property is displayed in the "Value" field. If the ActiveX
control does not allow reading of the current value, the field is captioned "Value (write-only)"
and the value is not displayed. The "Value" field appears as a text box or a combo box,
depending on the type of property.
There are three ways to edit a property:
1. If "Value" appears as a text box, type in the value and use the "Apply" button to indidate
that you have finished editing.
2. If "Value" appears as a combo box, you must pull down the combo box and select ap entry.
Properties... 3. If an additional dialog box is provided to select a value for the property, the "Select..)"
button is enabled.
Choose the "Select..." button. In the dialog box that appears, select a value. Return o the
"Properties” dialog box. To confirm, choose the "Apply" button.
To reset a property to its initial value, use the "Reset" button.
Note:
The initial value is not displayed as long as the "Properties" dialog box is still open. It is valid,
though, after the dialog box has been closed.
If you can edit the value of the property directly, the default value is displayed in the "Valye"
field. To select a value other than the default value, overwrite it.
For help on the selected property, click the "Help" button. (The help file for the ActiveX cdntrol
must have been installed).
To confirm the property settings, choose "Close".
About... Dialog box with information on the ActiveX control.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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ActiveX Control Property Pages

» Accessible Using

1. if selected: "Control > Property Pages..."; or
2. "Property Pages..." from the context menu.

Property pages are available with most ActiveX controls. They are used to configure the attributes of the ActiveX
control in an individual way. After an ActiveX control in a dialog has been configured using its property pages,
Natural stores the result of the configuration in binary form in the private resource file associated with the dialog. For
more information on resources see fregramming Guide Object Types - Resource.

Bitmap Control Attributes Window

» Accessible Using

1. Double-click on the bitmap control; or
2. if selected: "Control > Attributes" or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries
Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
Entry in
Attributes Represents
Window
Name Handle name of the bitmap control (may be overwritten with another name).
Array... "Array" dialog box for defining an array of bitmap controls.
. BITMAP-FILE-NAME attribute value. If you pull down the selection box, you can chooge
Bitmap e .
from the existing set of .bmp files.
"Source" dialog box for determining sources of BITMAP-FILE-NAME attribute values. Also
provides a list of all available bitmaps to be used.
DIL Text DIL-TEXT attribute value (string).
"Source" dialog box for determining sources of DIL-TEXT attribute values.
Accelerator ACCELERATOR attribute value.
Dialog box for determining sources of ACCELERATOR attribute values.
State:
Visible VISIBLE attribute value.
DRAGGABLE attribute value. If you check this item, the end user may drag the bitmap
Draggable . )
control and drop it onto another bitmap control.
Enabled ENABLED attribute value.
Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID [that
P you enter here to the corresponding help topic ID (created by a markup in the .hlipfile)
Command ID CLIENT-KEY attribute value (used in this context for associating a command ID).
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Bitmap Control Attributes Window

Entry in
Attributes
Window

Represents

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the

control.

Background
Color:

Selection box

BACKGROUND-COLOUR-NAME attribute value. If 'default’ is specified,
the color of the first (top-left) pixel in the bitmap determines the background color.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

The following four attributes decide the bitmap control’'s x and y axis position, its heigh
its width on the screen.
X - RECTANGLE-X attribute value.

Rectangle: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
Style:
Vertical
Justification:
Top / Center / Mutually exclusive STYLE attribute values: align to the
Bottom bottom, the vertical center, the top.
Horizontal
Justification:

Left / Center /

Mutually exclusive STYLE attribute values: align the bitmap

Right

to the left (of the rectangle), the horizontal center, the right.

Framed STYLE attribute value: three-dimensional frame.

Scaled STYLE attribute value: scale the bitmap to fit into the underlying bitmap control’s recta
STYLE attribute value: bitmap pixels in the background color do not change the state

Transparent
screen.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Canvas Control Attributes Window Dialog Editor

Canvas Control Attributes Window

» Accessible Using

1. Double-click on the canvas control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in
Attributes Represents
Window
Name Handle name of the canvas control (may be overwritten with another name).
Array... "Array" dialog box for defining an array of canvas controls.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL Text DIL-TEXT attribute value (string).
"Source" dialog box for determining sources of DIL-TEXT attribute values.
Help ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID fhat

you enter here to the corresponding help topic ID (created by a markup in the .hlp file).

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the
Context Menu

control.
Style:
Frame STYLE attribute value: creates a frame around the canvas control.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.

The following four attributes decide the canvas control’s x and y axis position, its height and
its width on the screen.

Rectanale: X - RECTANGLE-X attribute value.
neclangle. Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Foreground
Color:

Selection box FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.

34 Copyright Software AG 2002



Dialog Editor

Control Box Control Attributes Window

Control Box Control Attributes Window

» Accessible Using

1. Double-click on the control box control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

ntrols
Sible at

Entry in
Attributes Represents
Window
Name Handle name of the control box control.
State
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
Style:
Framed STYLE attribute value; creates a simple frame around the control box control.
Lowered STYLE attribute value; creates a 3-D border with a sunken appearance.
STYLE attribute value; marks the control box as exclusive. Amongst any set of sibling cq
Exclusive (i.e., controls with the same parent), only one control box marked as exclusive can be vi
any one time. This applies both in the Dialog Editor and at run-time.
STYLE attribute value; creates a transparent control box. Allows the control box itself to
Transparent

invisible without making the child controls it contains invisible.

be

Size to parent

STYLE attribute value; control boxes with this style are resized to fill the entire client are
their parent whenever the parent control is resized, or when this style is initially set in the
Dialog Editor.

h of

Rectangle:

The following four attributes decide the control box control’s x and y axis position, its hei
and

its width on the screen.

X - RECTANGLE-X attribute value.

Y - RECTANGLE-Y attribute value.

W - RECTANGLE-W attribute value.

H - RECTANGLE-H attribute value.

jht

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Invokes dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor

Dialog Attributes Window

» Accessible Using

1. Double-click on the dialog background; or
2. "Dialog > Attributes™; or by selecting 'Attributes...” from the dialog’s context menu or

3. ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attributes
Window

Represents

Name Handle name of the dialog window (may be overwritten with another name).
Tvpe TYPE attribute value. Allows you to decide whether the dialog provides a Multiple
yp Document Interface (MDI frame or MDI child) or not (standard).
String STRING attribute value (title of the "Dialog"” window).
"Source" dialog box for determining sources of STRING attribute values. For more
information on the "Source" dialog box, seeurce
Value of the FONT-STRING attribute. Decides the font for all dialog elements in this
Font dialog except for the system-supplied window decorations and the dialog elements f

which a font has been chosen explicitly.

"Font" dialog box for determining sources of STRING attribute values. For more
information on the "Font" dialog box, s8eurce

Context Menu

CONTEXT-MENU attribute value.
Specifies the context menu (if any) associated with the dialog itself.

Icon

BITMAP-FILE-NAME attribute value. Also provides a list of all available icons to be |

sed.

Help file

HELP-FILE-NAME attribute value. Decides a dialog’s help file name (without extens

on).

Default button

DEFAULT-BUTTON attribute value: type in or select the handle name of the push-b
control for which you want to assign this attribute.

itton

D that
).

allowed to dock.

Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical |
P you enter here to the corresponding help topic ID (created by a markup in the .hlp fil
Docking DOCKING attribue value. Determines the sides of the dialog (if any) on which tool bars are

Background Color:

Selection box

BACKGROUND-COLOUR-NAME attribute value. Choose a predefined color.

"Custom" dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

Style:

Modeless (Popup)
/Modal /Dialog box

Mutually exclusive values for the STYLE attribute.

Centered position

STYLE attribute value.

Dialog will be centered on screen.

36
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Dialog Editor

Dialog Attributes Window

Entry in Attributes
Window

Represents

Default position

STYLE attribute value. If set, the initial position (but not size) of the dialog is determi
by the windowing system.

The setting will be ignored if "Dialog box" is set. This option is especially useful for M
child dialogs.

hed

DI

Default rectangle

Value of the STYLE attribute. If set, the initial position and size of the dialog are dec
by the
windowing system. The setting will be ignored if "Dialog box" is set.

ded

Control clipping

Value of the STYLE attribute. If set, dialog elements are not allowed to overpaint oth
dialog elements with the same parent which occur later in the control sequence.

3-D client window

STYLE attribute value. If set, the dialog interior is drawn with a sunken 3-D appearance.

State:
Visible VISIBLE attribute value. If you check this entry, the dialog is visible.
Enabled ENABLED attribute value. If you check this entry, the end user may interact with the
dialog.
. MAXIMIZED attribute value. If you check this entry, the dialog is maximized to fill the
Maximized X
entire screen.
MINIMIZED attribute value. If you check this entry, the dialog is minimized to icon size.
Minimized The end user then will have to double-click on the icon to restore the dialog to its default
size.
If checked, the tool and status bar control layout will be automatically saved and resfored
Save layout on a per-user basis between sessions at run-time. This option is only available if the
dialog contains at least one tool bar or status bar control.
POPUP-HELP attribute value. Help for this dialog or any of its controls will be displayed
Popup help : .
in a popup window.
. AUTOADJUST attribute value. If you check this entry, the dialog will be scaled at run time
Auto-adjust . o wpm " -
according to the current system font size (i.e. "large fonts"/"small fonts" setting).
. EVENT-QUEUEING attribute value. If you check this entry, messages for this dialog|are
Event queueing : ) . )
gueued instead of being processed immediately.
Backaground color:
Selection box BACKGROUND-COLOUR-NAME attribute value. Choose a predefined color.
"Custom" dialog box for editing
BACKGROUND-COLOUR-VALUE attribute value.
Components:
MENU-HANDLE attribute value: if checked, the dialog editor will assign the handle vialue
Menu bar i X :
specified in the menu bar attributes window.
Toolbar HAS-TOOLBAR attribute value: if checked, the dialog editor will assign the handle value
specified in the toolbar attributes window and set HAS-TOOLBAR to TRUE.
Status bar HAS-STATUS-BAR attribute value. If you check this entry, the dialog has a status bar.

Dynamic info line

HAS-DIL attribute value. If you check this entry, the dialog has a dynamic informatio
line.

1
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Dialog Attributes Window

Dialog Editor

Entry in Attributes
Window

Represents

System button

HAS-SYSTEM-BUTTON attribute value. If you check this entry, the dialog has a sys
button.

fem

Size modifiable

SIZE-MODIFIABLE attribute value. If you check this entry, the dialog’s size may be
modified.

Maximizable

MAXIMIZABLE attributes value. If you check this entry, the dialog may be maximize

Minimizable

MINIMIZABLE attribute value. If you check this entry, the dialog may be minimized.

Horizontal scroll
bar

HORIZ-SCROLLABLE attribute value. If you check this entry, the dialog has a horizg
scroll bar.

ntal

Vertical scroll bar

VERT-SCROLLABLE attribute value. If you check this entry, the dialog has a vertica
scroll bar.

Help button

HAS-HELP-BUTTON attribute value. If you check this entry, the dialog title bar contd
help button.

Note: Windows does not display the help button if minimize and maximize buttons a
present.

lins a

e

Rectangle:

The following four attributes decide the dialog’s x and y axis position, its height and i
width on the screen.

X - RECTANGLE-X attribute value.

Y - RECTANGLE-Y attribute value.

W - RECTANGLE-W attribute value.

H - RECTANGLE-H attribute value.

S

OK

Save settings and exit the window.

Cancel

Exit the window without saving the settings.

Subroutines

Dialog box for editing subroutines.

Help

Provides online help on the attributes window.
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Dialog Editor

Dialog Context Menus Window

Dialog Context Menus Window

» Accessible Using

1. "Dialog > Context Menus"; or

2. CTRL+ALT+X.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in
Attributes
Window

Represents

Available Context
Menus

Shows the context menus currently defined for this dialog. One or more context menu
selected from this list.

5 can be

Creates a new, empty, context menu with a default name. The new context menu is in

serted

New into the list immediately after the selected context menu(s).
Cut Cuts the selected context menu(s) to the clipboard.
Paste Pastes context menu(s) from the clipboard, which are inserted into the list immediately

the selected context menu(s).

after

Selected Context
Menu

Shows information relating to the currently selected context menu. If multiple context 1
are selected, this section is disabled.

nenus

Name Displays the name of the currently selected context menu, which can be modified herg or in
the Menu Editor Window itself.

Enabled The initial ENABLED attribute state for the context menu. A disabled context menu is
suppressed at run-time.

Edit Invokes the menu editor for the selected context menu, where the menu items themselves can
be defined.

Events Invokes the event handler window for editing the events for the context menu itself. (The
events for the menu items and any submenus are accessed using the Menu Editor Wihdow).

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Edit Area Control Attributes Window

Edit Area Control Attributes Window

» Accessible Using

1. Double-click on the edit area control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Dialog Editor

Entry in Attributes
Window

Represents

Name Handle name of the edit area control (may be overwritten with another name).
Array... "Array" dialog box for defining an array of edit area controls.
String STRING attribute value.
"Source" dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL Text DIL-TEXT attribute value (string).

"Source" dialog box for determining sources of DIL-TEXT attribute values.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with
control.

the

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Modifiable MODIFIABLE attribute value. If this entry is checked, the end user may edit the text.

Horizontal scroll
bar

HORIZ-SCROLLABLE attribute value.

Vertical scroll bar

VERT-SCROLLABLE attribute value.

that

entered

jardless

Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical 1D

P you enter here to the corresponding help topic ID (created by a markup in the .hlp file].
LENGTH attribute value. Specifies the maximum number of characters which can be
into the edit area control.

Lenath Note:

9 Each line break consumes two characters (carriage return / line feed). This applies re
of whether the line break was explicitly entered by the user or implicitly inserted due t¢ word
wrapping.

Style:
Framed STYLE attribute value: creates a frame around the edit area control.
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Dialog Editor

Edit Area Control Attributes Window

Entry in Attributes
Window

Represents

STYLE attribute value: when text exceeds the width of the edit area control, it is
automatically wrapped to the next line.

Wordwrapped Note:
When you set the STYLE attribute value to "WORDWRAP", you cannot set the
HORIZ-SCROLLABLE attribute value to "TRUE" and vice versa.
STYLE attribute value: Text is vertically scrollable and is automatically scrolled upwar
when the ENTER key is pressed on the last displayed line.

Autoscroll Note:
This option only has an effect if the edit area control does not have a vertical scroll ba
Otherwise, the text is implicitly autoscrollable.
The following four attributes decide the edit area control's x and y axis position, its he
and its width on the screen.
X - RECTANGLE-X attribute value.

Rectangle:

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

ght

Foreaground color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Group Frame Control Attributes Window

Dialog Editor

Group Frame Control Attributes Window

» Accessible Using

1. Double-click on the group frame control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attributes
Window

Represents

Name Handle name of the group frame control (may be overwritten with another name).
Array... Dialog box for defining an array of group frame controls.
String STRING attribute value.
"Source" dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
Style:
Container STYLE attribute va}lug. 'If checked, al! existing controls within the group frame, and arfy
controls created within it, become children of the group frame.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.

Forearound color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

"Custom" dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

"Custom" dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

The following four attributes decide the group frame control's x and y axis position, it
height and its width on the screen.
X - RECTANGLE-X attribute value.

Rectangle. Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor

Input Field Control Attributes Window

Input Field Control Attributes Window

» Accessible Using

1. Double-click on the input field control; or
2. if selected: "Control > Attributes" or by selecting 'Attributes...” from the control’s context menu.
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in
Attributes Represents
Window
Name Handle name of the input field control (may be overwritten with another name).
Array... Dialog box for defining an array of input field controls.
String STRING attribute value.
"Source" dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with t
control.

nat

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Modifiable MODIFIABLE attribute value. If this entry is checked, the end user may edit the text.

Help ID HELP-ID attribute value. You mu_st use the hglp topic’s .h file to map the_ numerical _IDt
you enter here to the corresponding help topic ID (created by a markup in the .hlp file).

Edit mask EDIT-MASK attribute value (only enabled if STRING source is a linked variable).

Length LENGTH attribute value.

Left / Center /
Right

Mutually exclusive STYLE attribute values: align input to the left, the center, the right.
Note:
When you create an input field control, and you assign it a STYLE value of "Center" or

"Right", the input field control must be higher than the font. Otherwise, the STRING will|not
be displayed.
Mandatory STYLE attribute value: input is mandatory.
Upper case STYLE attribute value: input will be converted to UPPERCASE letters.
Nondisplay STYLE attribute value: input is displayed as a series of asterisks (for example, for pasgwords).

Foreground
color:
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Input Field Control Attributes Window

Dialog Editor

Entry in
Attributes
Window

Represents

Selection box

FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

The following four attributes decide the input field control’'s x and y axis position, its hei
and its width on the screen.
X - RECTANGLE-X attribute value.

jht

Reciangle: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor

List Box Control Attributes Window

List Box Control Attributes Window

» Accessible Using

1. Double-click on the list box control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

items

Entry in
Attributes Represents
Window
Name Handle name of the list box control (may be overwritten with another name).
Input field where you can specify the number of list box items in the list box control.
Items When you enter a number here, the dialog editor generates the corresponding list box
and the "Source" dialog box becomes enabled.
Dialog box for determining sources of the list box items’ STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Accelerator

ACCELERATOR attribute value.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the

control.

Dialog box for determining sources of ACCELERATOR attribute values.

hat

Help ID HELP-ID attribute value. You mu§t use the hfelp topic’s .h file to map the. numerical .ID
you enter here to the corresponding help topic ID (created by a markup in the .hlip file)

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Multiple selection

MULTI-SELECTION attribute value. If you check this entry, the end user may select
several list box items at a time.

nodify

e

Sorted SORTED attribute value. If you check this entry, the items are sorted and you cannot 1
them.
AUTOSELECT attribute value. If you check this entry, Natural automatically updates tk
Autoselect o . : X .
selection in response to a right mouse button click before displaying a context menu.
Style:
3-D Border STYLE attribute value: list box has sunken appearance.

Integral height

STYLE attribute value: partial rows are not displayed.
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List Box Control Attributes Window Dialog Editor

Entry in
Attributes Represents
Window
The following four attributes decide the list box control’'s x and y axis position, its height and
its width on the screen.
i X - RECTANGLE-X attribute value.
Rectangle:

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Foreground color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

"Custom" dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

"Custom" dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Dialog Editor Menu Editor Window

Menu Editor Window

» Accessible Using

1. First check the "Menu Bar" field in the "Dialog Attributes" window, then double-click on the dummy menu bar
in the dialog; or

2. "Dialog > Menu Bar" or by selecting 'Menu Bar...” from the menu bar’s context menu or

3. CTRL+ALT+M.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in

Attributes Represents

Window

Menu:

Name Handle name of the menu (may be overwritten with another name).

Lists the menu’s handle name and all of the menu items of MENU-ITEM-TYPE "Submenj
defined so far.

Submenus This list is indented, that is, the menu structure becomes visible. If you select an entry, itg
childrenmenu items

or submenu controls appear in the "Selected Submenu" group frame.

Displays the STRING attribute values of the menu items or submenu controls which have been
created as child

Selected of the "Submenus". You can edit the attributes of the currently "Selected Submenu" in the
submenu: "Selected Menu Item" group frame.
The entries marked ">" are submenus. (You can also select several menu items for cutting and
pasting.)
Enables the display of bitmaps within a menu. If not checked, no menu bitmaps will be
Cool menu displayed,

even if the menu items themselves have a bitmap assigned to them.

The width of images to be displayed alongside the menu items. Menu item bitmaps with &
different width will be scaled,
or truncated or extended (in the background color) to fit, depending on the value of the menu
item’s 'scaled’ attribute.

Image width

The height of images to be displayed alongside the menu items. Menu item bitmaps with|a
different height will be scaled,
or truncated or extended (in the background color) to fit, depending on the value of the menu
item’s 'scaled’ attribute.
The specified image height may determine the menu item height if larger than the standgrd menu
item height will allow.

Image height

Displays the STRING attribute values of the menu items or submenu controls which have been
created as child
of the "Submenus". You can edit the attributes of the currently "Selected Submenu" in thg
"Selected Menu Item" group frame.
The entries marked ">" are submenus. (You can also select several menu items for cutting and
pasting.)

174

Menu items:

Copyright Software AG 2002 47



Menu Editor Window

Dialog Editor

item:

one menu item be selected.

Entry in

Attributes Represents

Window

<< Parent When you are creating a menu hierarchy, these two push buttons enable you to navigatd to the
menu next higher level (<< Parent Menu) or the next lower level (Submenu >>) of the existing
Submenu >> | branches.

Selected menu | Displays the attribute values of the selected submenu for editing. For editing, it is necesspry that

Handle name of the menu item or submenu control (may be overwritten with another name

Name starting with the # sign).
Tvpe MENU-ITEM-TYPE attribute value for the selected menu item. If the type is "Submenu" dr
yp "Window submenu", this item is automatically changed into a submenu control.
SAME-AS attribute value (only available for MENU-ITEM-TYPE "Normal"); the selection pox
displays the signals available.
Same as If this field is filled, the fields for the attributes which are inherited from the referenced sighal
are disabled, and can only be
re-enabled if the link is broken again by deleting the "Same as" field contents.
MENU-ITEM-OLE attribute value. If a dialog has a menu bar and an OLE container contrpl is
OLE being edited in-place, this attribute decides whether a top-level menu item or a submenujcontrol
is not an OLE menu item, or whether it is an item that represents the OLE Container or Fle or
Window group.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Bitmap BITMAP-FILE-NAME attribute value.
Dialog box for determining sources of BITMAP-FILE-NAME attribute values. Also providgs a
list of all available bitmaps to be used.
DIL text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
Accelerator ACCELERATOR attribute value.
Dialog box for determining sources of ACCELERATOR attribute values.
Command ID | CLIENT-KEY attribute value (used in this context for associating a command ID).
Background
Color:
BACKGROUND-COLOUR-NAME attribute value to be used for display of the menu item|s
Selection box bitmap (if any).
If 'default’ is specified, the color of the first (top-left) pixel in the bitmap determines the
background color.
Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.
State:
Enabled ENABLED attribute value.
SHARED attribute value. CLICK events for this menu item will be forwarded to the active|MDI
Shared child dialog (if any).
This attribute is ignored for non-MDI dialogs.
Checked CHECKED attribute value (not applicable to submenu controls).
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Dialog Editor

Menu Editor Window

peified

no

Entry in

Attributes Represents

Window

Style:

Scaled STYLE attribute value: scale the menu item’s bitmap to fit the image height and width sp4
for the submenu.
STYLE attribute value: menu item bitmap pixels in the background color do not change the state

Transparent
of the screen.

Events Dialog box for editing event handlers; may only be used with the appropriate "Type" field
Creates a new submenu control or menu item. If you change the type in the "Type" field ¢f the

New "Selected Menu Item" group frame, it creates a menu item with a corresponding
MENU-ITEM-TYPE attribute value. Within a submenu, it creates a menu item.

Cut Cuts the selected menu item(s) and copies it (them) to the clipboard.

Copy Copies the selected menu item(s) to the clipboard.
Pastes menu item(s) from the clipboard.

Past Note:

aste The "New" and "Paste" entries insert menu items behind the currently selected item, or, i

items are selected, at the top of the list. You deselect items by holding down CTRL while
clicking on the selected items.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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OLE Container Control Attributes Window

OLE Container Control Attributes Window

» Accessible Using

1. Double-click on the OLE container control; or
2. if selected: "Control > Attributes"; or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Dialog Editor

Entry in

Attributes Represents

Window

Name Handle name of the OLE container control (may be overwritten with another name).
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Accelerator

ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.

Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID that
P you enter here to the corresponding help topic ID (created by a markup in the .hlp file).
Object
Information:
In this group box, you decide the OLE object’s type whose name is then displayed.
Decides whether the OLE container control contains an OLE server, a new OLE object] an
existing OLE object, or none of all. For more information on these three type&xlseting
Type an OLE Server or Document
Note:
This is not a value of the TYPE attribute.
Dialog box for selecting a particular OLEserver, a new OLE object, or an existing Naturpl
embedded OLE object.
EMBEDDED-OBJECT, SERVER-OBJECT and SERVER-PROGID attribute values.
Name Displays the name of the selected item. You cannot edit this entry.
Framed STYLE attribute value: draw a frame around the OLE container control.
ZOOM-FACTOR attribute value: magnify or reduce the default representation of an OLE
Zoom (%) s S i
server application that has become visible in an OLE container control.
Status:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
o MODIFIABLE attribute value. If this entry is checked, the end user may modify the OLE
Modifiable L
object in-place.
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Dialog Editor

Selecting an OLE Server or Document

Entry in
Attributes Represents
Window
The following four attributes decide the OLE container control’s x and y axis position, it$
height and its width on the screen.
i X - RECTANGLE-X attribute value.
Rectangle:

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

g;\irStart Save settings, start the OLE server and exit the window.
OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.

Selecting an OLE Server or Document

If you select an OLE server or document, the three options "OLE server", "OLE object" and "Existing OLE object"
imply a number of restrictions when using Natural and when using the server application.

Differences Between OLE Server, New OLE Object and Existing OLE Object

Before you select an entry, decide if this is what you need.

Type Characteristics

Creates an OLE object in its native form. Either server with no content ("Create New") or $erver
OLE Server . - . " -

with existing file as content ("Create from File").
New OLE Creates a new OLE embedded object to be stored within the Natural environment (defaulf file
Object extension ".neo"). Only "Create New" allowed.
Existing OLE | Creates an existing OLE embedded object that has been stored within the Natural enviropment
Object (default file extension ".neo"). Only "Create from File" allowed. T
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Selecting an OLE Server or Document Dialog Editor

OLE Server
If you have selected the "OLE server" entry

1. Select the "..." button to the right of the drop-down combo box.
The "Select OLE Server or Document” dialog box appears. Here you have two options:

® The "Create New" radio button enables you to select a server application to be started when the end user
activates the OLE container control at runtime. The server application is started as such, with no file
loaded into it.

® The "Create from File" radio button enables you to insert the contents of a file as an OLE object. You can
browse for the file. When the end user activates the OLE container control at runtime, the application used
to create the file is started as a server application, with the content being the selected file.

2. Either select "Create New".

Or select "Create from File".
If you have selected "Create New", proceed with 3a.
If you have selected "Create from File", proceed with 3b.

3. 3a. - From the "Object Type" list box, select an application, for example "Microsoft Word 6.0 Document".
3b. - In the file text box, enter the path of the file you want to select.

Or, if you are not sure where the file is, choose the "Browse" button to search in your environment.

4. Select the "Display as Icon" check box or not. This lets you decide whether you want to display your
application or file as an application icon inside the OLE container control or whether you want your application
or file to appear as a text string calledapglicationname> or <pathname>. Both act as a placeholder for
the server application.
If you choose to display the application or file as an icon, you can customize the icon by selecting the "Change
Icon..." button.

5. To save your settings and quit the dialog box, select OK.
Or select "Cancel" to quit without saving.

» To edit an OLE object inside an OLE container control at runtime
Prerequisite: you have selected "OLE server".

1. Click and hold down the right mouse button inside the OLE container control’s rectangle.
The pop-up menu specific to your server application appears, saying for example:
Edit object-typ©biject; or
object-typeObject with the submenus "Edit" and "Open".
"Open" activates the server application in a separate window and enables you to edit and save the object. You
can then quit the server application and return to Natural. "Edit" lets you activate the server application inside
your Natural dialog.

2. Make your selection in the pop-up menu.

3. Edit (and save) your object using the menu entries provided by the OLE server application.

» To quit the OLE server application at runtime
If you have chosen "Edit":

® Click outside the OLE container control’s rectangle.
The OLE server application is deactivated in the Natural dialog, but the object is still displayed inside the OLE
container control.

If you have chosen "Open":

® From the OLE server application’s menu, select "File", then "Close and Rettont&iner-application-nanie
The object is unloaded from the OLE server application in the separate window, but the object is still displayed
inside the OLE container control.
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og Editor Selecting an OLE Server or Document

New OLE Object
ou have selected the "New OLE object" entry, do the following:

. Select the "..." button to the right of the drop-down combo box.

The "Select OLE Server or Document” dialog box appears. Important: Here you may only select "Create New",
even though the other option is not disabled.

. Select "Create New".

From the "Object Type" list box, select an application, for example "Microsoft Word 6.0 Document".

. Select the "Display as Icon" check box or not. This lets you decide whether you want to display your object as
an application icon inside the OLE container control or whether you want your object to appear as a text string
called <<applicationnama>.

If you choose to display the application or file as an icon, you can customize the icon by selecting the "Change
Icon..." button.

. To save your settings and quit the dialog box, select OK.

Or select "Cancel" to quit without saving.

You have returned to the attributes window. Note that your server's name now appears in the "Name" text box,

prepended by an "@". This is the current value of the "SERVER-PROGID" attribute. The OK button is

disabled. Instead, the "OK & Start Server" button is enabled.

Ensure you have made all choices in the attributes window.

. Choose "OK & Start Server".

Your attributes window settings are saved and the server application is started.

. Create your OLE object.

. Quit the server application. The server application usually provides the menu entries "File", then "Close and
Return tocontainer-application-nanie
A file list box called "Save As" appears.

. Save the file as a Natural embedded object with the default file extension ".neo".

If your end user has edited your new OLE object at runtime

. To edit it in-place, the server application provides additional entries to the Natural application’s menu bar.

. To quit the server application, the server application usually provides the menu entries "File", then "Close and
Return tocontainer-application-nanie
Note:
Depending on the server application, you might have to set the focus back to Natural as the server applications
usually remain active.
A file list box called "Save As" appears.

. The end user must save the file as a Natural embedded object with the default file extension ".neo".

Existing OLE Object
ou have selected the "Existing OLE object" entry:

. Select the "..." button to the right of the drop-down combo box.
The "Select existing Natural Embedded Object” dialog box appears. It displays all Natural embedded objects
with the default file extension ".neo" in the default directory.
. Select a file.
Both the OK and the "OK & Start Server" buttons are enabled. You now have two options:
e If you quit the attributes window by selecting OK, the embedded object will be shown in the container, but
cannot be modified (read-only).
e If you quit the attributes window by selecting "OK & Start Server", the corresponding server application is
started and the chosen object can be modified (read-write).
. Choose "OK & Start Server".
Or choose OK.
Your attributes window settings are saved and the server application is started.
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4. Modify your OLE object (if you have chosen "OK & Start Server" and the object is read-write).
Or look at your OLE object (if you have chosen OK and the object is read-only).
5. Quit the server application. The server application usually provides the menu entries "File", then "Close and

Return tocontainer-application-nanie

A file list box called "Save As" appears.
6. If you confirm the default, the file is automatically saved as a Natural embedded object with the default file

extension ".neo".
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Dialog Editor Push Button Control Attributes Window

Push Button Control Attributes Window

» Accessible Using

1. Double-click on the push-button control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
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Push Button Control Attributes Window

Dialog Editor

Entry in Attributes

Window Represents
Name Handle name of the push-button control (may be overwritten with another name).
Array... Dialog box for defining an array of push-button controls.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Accelerator

ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with
control.

the

that

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Help ID HELP-ID attribute value. You mu§t use the hglp topic’s .h file to map the. numerical .ID
you enter here to the corresponding help topic ID (created by a markup in the .hlip file].

Style:

OK Button STYLE attribute value: if the end user presses ENTER, this button is pushed.

Cancel Button

STYLE attribute value: if the end user presses ESC, this button is pushed.

Command ID

CLIENT-KEY attribute value (used in this context for associating a command ID).

The following four attributes decide the push button control’s x and y axis position, its
and its width on the screen.
X - RECTANGLE-X attribute value.

height

Reclangic: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor Radio Button Control Attributes Window

Radio Button Control Attributes Window

» Accessible Using

1. Double-click on the radio-button control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected:ENTER.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
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Entry in
Attributes Represents
Window
Name Handle name of the radio-button control (may be overwritten with another name).
Array... Dialog box for defining an array of radio-button controls.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
Accelerator ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the
Context Menu

control.

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Checked CHECKED attribute value.

Help ID HELP-ID attribute value. You mu;t use the hglp topic’s .h file to map the. numerical .ID hat
you enter here to the corresponding help topic ID (created by a markup in the .hlp file)

Group ID GROUP-ID attribute value (means this radio-button control belongs to the group of radio

buttons with this ID).

The following four attributes decide the radio-button control’'s x and y axis position, its height
and its width on the screen.
Rectangle: X - RECTANGLE-X attribute value.
neclangle Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Forearound color:

Selection box FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background
color:

Selection box BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Scrollbar Control Attributes Window

Scrollbar Control Attributes Window

» Accessible Using

1. Double-click on the scroll-bar control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected:ENTER

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Entry in
Attributes Represents
Window
Name Handle name of the scroll-bar control (may be overwritten with another name starting with the #
sign).
Array... Dialog box for defining an array of scroll-bar controls.
DIL text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID thaf you
P enter here to the corresponding help topic ID (created by a markup in the .hlp file).
CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the
Context Menu
control.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
Values:
Minimum MIN attribute value (minimum numerical value on the scale).
Maximum MAX attribute value (maximum numerical value on the scale).
Line LINE attribute value (number of logical units by which the slider moves if the end user presses
the up and down arrow buttons).
PAGE attribute value (number of logical units by which the slider moves if the end user cl{cks on
Page ,
the scroll-bar control’s shaft).
Slider SLIDER attribute value (position of the slider in between the MIN and MAX values).
The following four attributes decide the scroll-bar control’'s x and y axis position, its heighfand
its width on the screen.
. X - RECTANGLE-X attribute value.
Rectangle:
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Entry in
Attributes Represents
Window
Mutually exclusive STYLE attribute values: slider will scroll horizontally or vertically.
Note:
Horizontal / When you edit the STYLE attribute value in the scroll-bar control attributes window, setting "h"
Vertical instead of "v" and vice versa, the RECTANGLE-H and RECTANGLE-W attribute values are

exchanged. The dialog editor thus ensures that the scroll-bar control will not provide for vertical
scrolling in a horizontal shape and vice versa.

Background
color:

Selection box |BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor

Selection Box Control Attributes Window

Selection Box Control Attributes Window

» Accessible Using

1. Double-click on the selection box control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

n box

Entry in
Attributes Represents
Window
Name Handle name of the selection box control (may be overwritten with another name).
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Input field where you can specify the number of selection box items in the selection bo
ltems control.
When you enter a number here, the dialog editor generates the corresponding selectig
items and the corresponding "Source" dialog box becomes enabled.
Dialog box for determining sources of the selection box items’ STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the

nodify

hat

control.

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Modifiable MODIFIABLE attribute value.

Sorted SORTED attribute value. If you check this entry, the items are sorted and you cannot 1
them.

Help ID HELP-ID attribute value. You mu_st use the h_elp topic’s .h file to map the_ numerical _ID
you enter here to the corresponding help topic ID (created by a markup in the .hlp file)

Edit mask EDIT-MASK attribute value.

Length LENGTH attribute value.
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Entry in
Attributes Represents
Window
The following four attributes decide the selection box control's x and y axis position,
its height and its width on the screen.
i X - RECTANGLE-X attribute value.
Rectangle:

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Foreground color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

Mandatory STYLE attribute value: input in the selection box control’s input field is mandatory.
gg;(vr?ropped STYLE attribute value: the box stays dropped down all the time.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Signal Attributes Window

Signal Attributes Window

» Accessible Using

1. "Dialog> Signals"; o

2. CTRL+ALT+N.

Entries

Note:

r

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attributes
Window

Represents

Displays the handle name of the signals already created. If you click on a signal i the

hg and

no signals are selected,
at the top of the list. You deselect items by holding down CTRL while clicking on t
selected items.

. ) list,

Signals: its attributes are displayed for editing. You can also select several signals for cultti
pasting.

New Creates a new signal.

Cut Cuts the selected signal and copies it to the clipboard. You can also cut and past¢ several
signals at once.

Copy Copies the selected signal(s) to the clipboard.
Pastes a signal from the clipboard.
Note:

Paste The "New" and "Paste" entries insert signals behind the currently selected signal,

or, if

Selectedsignal:

In this group frame, you assign attribute values to the signals selected in the "Sigpals"

list box on the left.

Name Handle name of the signal (may be overwritten with another name).

Type MENU-ITEM-TYPE attribute value for the selected signal.

Bitmap BITMAP-FILE-NAME attribute value.
Dialog box for determining sources of BITMAP-FILE-NAME attribute values.
Also provides a list of all available bitmaps to be used.

DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Accelerator

ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.

Tooltip

TOOLTIP attribute value.

Dialog box for determining sources of TOOLTIP attribute values.

Command ID

CLIENT-KEY attribute value (used in this context for associating a command ID).

Background Color:
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Dialog Edito

r

Entry in Attributes
Window

Represents

Selection box

BACKGROUND-COLOUR-NAME attribute value to be used for display of the signal’'s

bitmap (if any).

If 'default’ is specified, the color of the first (top-left) pixel in the bitmap determineg the
background color.
Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
Checked CHECKED attribute value.
Shared SHARED. attribute vglue_. If chgcked, CLI.CK eyents _for this signal will be forvyarded
to the active MDI child dialog (if any). This attribute is ignored for non-MDI dialogs.
Events Dialog box for editing event handlers; may only be used with the appropriate "Typge"
entry.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Status Bar Control Attributes Window

Status Bar Control Attributes Window

» Accessible Using

1. Double-click on the status bar control; or
2. if selected: "Control>Attributes " or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in

Attributes Represents

Window

Name Handle name of the status bar control (may be overwritten with another name)
Subordinate window for editing the status bar control’s attribute values. For more informaon,
seeStatus Bar Control Attributes Subwindo{ormally, all attributes of a dialog element can be

Attributes... edited in the attributes window. Instead, the attributes of each pane in the status bar contqol can be
edited here. For reasons of space, the status bar control’s attributes are edited in a separgte
subwindow).

Status-bar Displays the handle name of the panes already created. If you click on a pane in this list,

panes: its attributes are displayed for editing. You can also select several panes for cutting and ppsting.

New Creates a new pane.

cut Cuts the selected pane and copies it to the clipboard. You can also cut and paste several [panes at
once.
Pastes a pane from the clipboard.
Note:

Paste The "New" and "Paste" entries insert panes behind the currently selected item, or, if no itgms are

selected,
at the top of the list. You deselect items by holding down CTRL while clicking on the seleqted
items.

Selected status

In this group frame, you assign attribute values to the panes selected in the "Status bar panes" list

bar pane: box on the left.
Name Handle name of the pane (may be overwritten with another name).
ITEM-W attribute value. Specifies the width of the pane in pixels.
Width Note:
If 0, the pane does not have a fixed width, but is instead automatically sized to fill the spage
available ("stretchy pane").
String STRING attribute value. Specifies the initial pane text.
Dialog box for determining sources of STRING attribute values.
BITMAP-FILE-NAME attribute value. Species the icon (if any) to be displayed alongside the
pane text.
Note: Natural attempts to extract the small (16x16 pixel) icon (if any) from the specified icgn
Icon file.

If only a large (32x32 pixel) icon is present, Windows will automatically synthesize a smallicon
from it,
which may lead to undesirable scaling effects.
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Entry in

Attributes Represents

Window
Dialog box for determining sources of BITMAP-FILE-NAME attribute values.
Also provides a list of all available icons to be used.

Tooltip TOOLTIP attribute value.

Dialog box for determining sources of TOOLTIP attribute values.

Command ID

CLIENT-KEY attribute value (used in this context for associating a command ID).

State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
Shared SHARED. attribute vglue_. If che_cked, CLI.CK eyents )‘or this pane will be forvv_arded
to the active MDI child dialog (if any). This attribute is ignored for non-MDI dialogs.
Style:
Centered STYLE attribute value. If set, text will be horizontally centered within the pane.
Hide disabled S_TYLE attribu_te value. If set, the pane text ar_1d ic_;on (if any) will be hidden
(instead of being grayed out) when the pane is disabled.
Raised STYLE attribute value. If set, the pane appears to "pop out".
No borders ST_YLE att_ributg value. If get, the pane borders are not drawn.
This style is typically applied to stretchy panes.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Editor Status Bar Control Attributes Subwindow

Status Bar Control Attributes Subwindow
» Accessible Using
1. Click on the "Attributes..." button in the status bar control attributes window

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
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Status Bar Control Attributes Subwindow

Dialog Editor

Entry in Attrib.
Subwindow

Represents

Control ID

CLIENT-KEY attribute value (used in this context for associating a user-defined D).

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated
the control.

vith

Location

LOCATION attribute value. Determines the side of the dialog on which the status
control is initially positioned.

bar

Internal Metrics:

Minimum height

ITEM-H attribute value. Specifies theinimumheight of the status bar panes (in pixe
This is particularly useful for status bar controls which display icons. By default, th
minimum

height of a status bar control depends on the font used to draw the text.

s).

he

[atus

f the

m of

a3-D

. MARGIN-X attribute value. Specifies the margin (in pixels) to the left and right of t
Margin-X
status bar panes.
Marain-Y MARGIN-Y attribute value. Specifies the margin (in pixels) above and below the g
9 bar panes.
Borders:
To STYLE attribute value. Species whether a border should be displayed at the top g
P control.
STYLE attribute value. Species whether a border should be displayed at the bottg
Bottom
the control.
3-D STYLE attribute value. If set, the status bar control borders (if any) are drawn with
appearance.
Style:
. STYLE attribute value. Determines whether a sizing gripper is displayed within thg
Gripper
status bar control.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
: HAS-TOOLTIP attribute value. If not set, display of the tool tip text (if any)
Tooltips .
for the status bar panes will be suppressed.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Table Attributes Window

Table Attributes Window

» Accessible Using

1. Double-click on the table; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

attributes are displayed for editing. You can also select several column specifications fo
and pasting.

SelectedColumn

Specification:

Entry in

Attributes Represents

Window

Table:

Name Handle name of the table (may be overwritten with another name)
Subordinate window for editing the table’s attribute values. For more informationalskse

Attributes Attributes Subwindow(Normally, all attributes of a dialog element can be edited in the

attributes window. Instead, the attributes of each column specification control in the tablg¢ can

be edited here. For reasons of space, the table’s attributes are edited in a separate subwindow).
Displays the handle name, the COLUMN-TYPE and the STRING attribute values of the

Columns: column specification controls already created. If you click on a column specification control, its

cutting

In this group frame, you assign attribute values to the column specification controls sele¢ted in

the "Columns" list box on the left.

Name

Handle name of the column specification control (may be overwritten with another name).
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COLUMN-TYPE attribute value for the selected column specification control. If the type
Type "Selection Box", the "ltems" entry is enabled and enables you to define the number of se
box items and the source of their values.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
DIL text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
ltems If the "Type" entry is set to "Selection Box", this entry is enabled and allows you to enter
number of selection box items.
Dialog box for determining sources of selection box item values.
Helo ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID that you
P enter here to the corresponding help topic ID (created by a markup in the .hlp file).
Width RECTANGLE-W attribute value.
Length LENGTH attribute value.
State:
Modifiable MODIFIABLE attribute value.



Table Attributes Window

Dialog Editor

ame,
alue.

s by

Entry in

Attributes Represents

Window
Creates a new column specification control.

New If you change the type in the "Type" field of the "Selected Column Specification" group fi
it creates a column specification control with a corresponding COLUMN-TYPE attribute

Cut Cuts the selected column specification control(s) and copies it (them) to the clipboard.
Pastes the selected column specification control(s) from the clipboard.

Note:

Paste The "New" and "Paste" entries insert column specification controls behind the currently
selected control, or, if no controls are selected, at the top of the list. You deselect contro,
holding down CTRL while clicking on the selected controls.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Table Attributes Subwindow

Table Attributes Subwindow

» Accessible Using

® Click on the "Attributes..." button in the table attributes window.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attrib.

Subwindow Represents
Name Handle name of the table (may be overwritten with another name).
Font Output field where the font currently selected is displayed.

Dialog box for selecting fonts.

Header font

Output field where the font currently selected for the table header is displayed.

Dialog box for selecting fonts.

DIL text

DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values.

Context Menu

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the

control.

The following four attributes decide the table’s x and y axis position, its height and its \
on the screen.
X - RECTANGLE-X attribute value.

Rectangle: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

Row count ROW-COUNT attribute value.

Row height ROW-HEIGHT attribute value.

Header height

HEADER-HEIGHT attribute value.

Width 1st col. FIRST-COLUMN-WIDTH attribute value.
Frozen cols. FROZEN-COLUMNS attribute value.
Help ID HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID

you enter here to the corresponding help topic ID (created by a markup in the .hlp file)

First visible col.

FIRST-VISIBLE-COLUMN attribute value.

First visible row

FIRST-VISIBLE-ROW attribute value.

Columns header

STYLE attribute value: buttons with field names are displayed at the top of each colum

Extendable

STYLE attribute value: end users can delete and insert rows using DEL and INS.

No lines

STYLE attribute value: the table control is displayed without the lines that normally sef
the cells.

Resize columns

STYLE attribute value: end users may resize the columns horizontally.
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Table Attributes Subwindow

Dialog Editor

Single cell
selection

STYLE attribute value:

select ranges of cells.

if set, end users may only select single cells. If not set, end usgrs may

Resize rows

STYLE attribute value:

end users may resize the rows vertically.

Whole row
selection

STYLE attribute value:

selecting an individual cell sets the selection to the entire row.

Draggable
columns

STYLE attribute value:

if set, end users may drag the columns.

Integral height

STYLE attribute value:

partial rows are not displayed.

Foreaground color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background
color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

State:

Visible VISIBLE attribute value.
Enabled ENABLED attribute value.
Modifiable MODIFIABLE attribute value.

Has first column

HAS-FIRST-COLUMN attribute value.

Horizontal scroll
bar

HORIZ-SCROLLABLE attribute value.

Vertical scroll bar

VERT-SCROLLABLE attribute value.

OK

Save settings and exit the window.

Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Text Constant Control Attributes Window

Text Constant Control Attributes Window

» Accessible Using

1. Double-click on the text constant control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attributes
Window

Represents

Name Handle name of the text constant control (may be overwritten with another name).
Array... Dialog box for defining an array of text constant controls.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
Style:

Left / Centered /
Right

Mutually exclusive STYLE attribute values: align output to the left, the center, the ri

pht.

Framed STYLE attribute value: draw a frame around the text constant control.

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.
The following four attributes decide the text constant control’s x and y axis position
height and its width on the screen.

) X - RECTANGLE-X attribute value.
Rectangle:

Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

its

Foreground color:

Selection box

FOREGROUND-COLOUR-NAME attribute value.

Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background color:

Selection box

BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Timer Attributes Window

» Accessible Using

1. "Dialog > Timers"; or

2. CTRL+ALTHI.

Entries

Note:

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

r

Entry in

Attributes Represents

Window

Timer: Displays the handle names and the TIMER-INTERVAL attribute values of the timers alr

created. (You may create up to 16 timers per dialog).

bady

SelectedTimer:

In this group frame, you assign attribute values to the timer selected in the "Timers" list
the left.

box on

veral

ne is
on

Name Handle name of the timer (may be overwritten with another name starting with the # sig
Interval TIMER-INTERVAL attribute value.
Events Dialog box for editing event handlers.
New Creates a new timer.
cut Cuts the selected timer and copies it to the clipboard. (You can cut and paste one or se
timers).
Pastes timer(s) from the clipboard.
Past Note:
aste The "New" and "Paste" entries insert timers behind the currently selected timer, or, if ng
selected, at the top of the list. You deselect timers by holding down CTRL while clicking
the selected timers.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Toggle Button Control Attributes Window

» Accessible Using

1. Double-click on the toggle-button control; or
2. if selected: "Control > Attributes™ or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
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Toggle Button Control Attributes Window Dialog Editor

Entry in
Attributes Represents
Window
Name Handle name of the toggle-button control (may be overwritten with another name).
Array... Dialog box for defining an array of toggle-button controls.
String STRING attribute value.
Dialog box for determining sources of STRING attribute values.
Font Output field where the font currently selected is displayed.
Dialog box for selecting fonts.
DIL text DIL-TEXT attribute value (string).
Dialog box for determining sources of DIL-TEXT attribute values.
Accelerator ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.

CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with the

Context Menu
control.

HELP-ID attribute value. You must use the help topic’s .h file to map the numerical ID fhat

Help ID you enter to the corresponding help topic ID (created by a markup in the .hlp file).
State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value.

Checked CHECKED attribute value.

Foreaground color:
Selection box FOREGROUND-COLOUR-NAME attribute value.
Dialog box for editing FOREGROUND-COLOUR-VALUE attribute value.

Background color:
Selection box BACKGROUND-COLOUR-NAME attribute value.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

The following four attributes decide the toggle-button control's x and y axis position, its
height and its width on the screen.
Rectangle: X - RECTANGLE-X attribute value.
neclange. Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.

OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Toolbar Attributes Window

» Accessible Using

1. "Dialog > Toolbar"; or

2. first check the "Toolbar" entry in the dialog attributes window, then double-click on the dummy toolbar in the
dialog; or select 'Toolbar...” from the toolbar’'s context menu.

3. CTRL+ALT+T.

Entries

Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in

Attributes Represents

Window

Name Handle name of the toolbar (may be overwritten with another name).
Position TOOLBAR-POS attribute values.

STYLE attribute value: if set and there are more toolbar items than can be displayed on the top
Wrapped of the dialog, the toolbar wraps around to a new line. (The default: the toolbar can be sciolled
with the two small arrow push buttons on the left of the toolbar.)

MARGIN-X attribute value (specifies which margin to the left, to the right and above the
Margin-X bitmaps is displayed in the toolbar area. This attribute only applies if TOOLBAR-POS is get to
TB-LEFT or TB-RIGHT.

MARGIN-Y attribute value (specifies which margin to the left, above and below the bitmaps is

Margin-Y displayed in the toolbar area. This attribute only applies if TOOLBAR-POS is set to TB-T|OP or
TB-BOTTOM.

Item width ITEM-W attribute value (specifies the width of all items in the toolbar).

Item height ITEM-H attribute value (specifies the height of all items in the toolbar).

Toolbar Displays the handle name and the BITMAP-FILE-NAME of the existing toolbar items.

Selected toolbar | In this group frame, you assign attribute values to the toolbar item selected in the "Toolbgar
item: items" group frame on the left.

Name Handle name of the toolbar item (may be overwritten with another name).
Type MENU-ITEM-TYPE attribute value for the selected toolbar item.
SAME-AS attribute value (not for MENU-ITEM-TYPE "Separator"); the selection box displays
Same as . .
the menu items available.
Bitmap BITMAP-FILE-NAME attribute value.
Dialog box for determining sources of BITMAP-FILE-NAME attribute values. Also providps a
list of all available bitmaps to be used.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values (not for MENU-ITEM-TYPE
"Separator").

Accelerator ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.
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Dialog Edito

r

Entry in
Attributes
Window

Represents

Command ID

CLIENT-KEY attribute value (used in this context for associating a command ID).

Background
Color:

Selection box

BACKGROUND-COLOUR-NAME attribute value to be used for display of the item’s bitnpap

(if any).
If 'default’ is specified, the color of the first (top-left) pixel in the bitmap determines the
background color.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value (not for MENU-ITEM-TYPE "Separator").
Checked CHECKED attribute value (not for MENU-ITEM-TYPE "Separator").
SHARED attribute value. CLICK events for this item will be forwarded to the active MDI ¢hild
Shared dialog (if any).
This attribute is ignored for non-MDI dialogs.
Style:
Scaled STYLE attribute value: allows for stretched bitmaps to be displayed on the toolbar items
STYLE attribute value: bitmap pixels in the background color do not change the state of the
Transparent
screen.
Dialog box for editing event handlers; may only be used with the approriate "Type" entry
Events may not be used if the toolbar item is associated with a menu item using the SAME-AS
attribute.
New Creates a new toolbar item.
Cut Cuts a selected toolbar item and copies it to the clipboard. You can also cut and paste sgveral
toolbar items at once.
Pastes a toolbar item from the clipboard.
Note:
Paste The "New" and "Paste" entries insert toolbar items behind the currently selected item, o},
if no items are selected, at the top of the list. You deselect items by holding down CTRL jwhile
clicking on the selected items.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.

Tool Bar Control Attributes Window

»  Accessible Using

1. Double-click on the tool bar control; or
2. if selected: "Control > Attributes" or by selecting 'Attributes...” from the control’s context menu or
3. if selected: ENTER.
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Entries

Note:

Tool Bar Control Attributes Window

For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.

Entry in Attributes
Window

Represents

item:

bar items" list box on the left.

Name Handle name of the tool bar item (may be overwritten with another name).
Type MENU-ITEM-TYPE attribute value for the selected tool bar item.
RECTANGLE-W attribute value. This is only available for MENU-ITEM-TYPE
Width "Separator"”
and specifies the separator width (0 = default separator width).
SAME-AS attribute value (only available for MENU-ITEM-TYPE "Normal");
Same as . . . . .
the selection box displays the signals and menu items available.
Bitmap BITMAP-FILE-NAME attribute value.
Dialog box for determining sources of BITMAP-FILE-NAME attribute values.
Also provides a list of all available bitmaps to be used.
DIL text DIL-TEXT attribute value (string).

Dialog box for determining sources of DIL-TEXT attribute values (not for
MENU-ITEM-TYPE "Separator").

Accelerator

ACCELERATOR attribute value.

Dialog box for determining sources of ACCELERATOR attribute values.
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Name Handle name of the tool bar control (may be overwritten with another name).
Subordinate window for editing the tool bar control’s attribute values. For more
information,
see Tool Bar Control Attributes Subwindow. (Normally, all attributes of a dialog element

Attributes can

be edited in the attributes window. Instead, the attributes of each tool bar item in thq tool
bar
control can be edited here. For reasons of space, the tool bar control’s attributes arg edited
in a separate subwindow).
Displays the handle name and the BITMAP-FILE-NAME attribute values of the tool bar

Tool bar items: items already created.

EE— If you click on a tool bar item, its attributes are displayed for editing. You can also sg¢lect
several tool bar items for cutting and pasting.

New Creates a new tool bar item.

Cut Cuts a selected tool bar item and copies it to the clipboard. You can also cut and pajste
several tool bar items at once.

Pastes a tool bar item from the clipboard.
Note:

Paste The "New" and "Paste" entries insert tool bar items behind the currently selected item, or,
if no items are
selected, at the top of the list. You deselect items by holding down CTRL while clickjng on
the selected items.

Selected tool bar In this group frame, you assign attribute values to the tool bar items selected in the {Tool



Tool Bar Control Attributes Window

Dialog Edito

r

Entry in Attributes
Window

Represents

Tooltip

TOOLTIP attribute value.

Dialog box for determining sources of TOOLTIP attribute values.

Command ID

CLIENT-KEY attribute value (used in this context for associating a command ID).

Background Color:

Selection box

BACKGROUND-COLOUR-NAME attribute value to be used for display of the item’s
bitmap (if any).

If 'default’ is specified, the color of the first (top-left) pixel in the bitmap determines the

background color.

Dialog box for editing BACKGROUND-COLOUR-VALUE attribute value.

9%
3
12

ntry;
AS

State:

Visible VISIBLE attribute value.

Enabled ENABLED attribute value (not for MENU-ITEM-TYPE "Separator").

Checked CHECKED attribute value (not for MENU-ITEM-TYPE "Separator"”).
SHARED attribute value. CLICK events for this item will be forwarded to the active VDI

Shared child dialog (if any).
This attribute is ignored for non-MDI dialogs.

Style:

Scaled STYLE attribute value: allows for stretched bitmaps to be displayed on the toolbar it

Wrapped STYLE attribute value: if set, tool bar item is started on a new row.
STYLE attribute value: bitmap pixels in the background color do not change the state of

Transparent
the screen.
Dialog box for editing event handlers; may only be used with the approriate "Type"

Events may not be used if the toolbar item is associated with a menu item using the SAME-
attribute.

OK Save settings and exit the window.

Cancel Exit the window without saving the settings.

Help Provides online help on the attributes window.
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Tool Bar Control Attributes Subwindow

Tool Bar Control Attributes Subwindow

» Accessible Using

1. - Click on the "Attributes..." button in the tool bar control attributes window.
Entries
Note:
For context-sensitive help on attribute entries, select the entry so it has the focus, and press F1.
Entry in Attributes Represents
Subwindow P
. STRING attribute value. This is the text displayed in the window caption when a
String .
dockable tool bar control is floated.
Dialog box for determining sources of STRING attribute values.
Control ID CLIENT-KEY attribute value (used in this context for associating a user-defined ID).
CONTEXT-MENU attribute value. Specifies the context menu (if any) associated with
Context Menu
the control.
DOCKING attribue value. Determines the sides of the dialog (if any) on which this ool
Dockin bar is
9 allowed to dock (if dockable). Note: The dialog itself must also support docking on fthe
specified side(s).
LOCATION attribute value. Determines the side of the dialog on which the tool bar
Location control
is initially positioned, or whether the tool bar control is floated in a separate windowy (if
dockable).
Internal Metrics:
Item width ITEM-W attribute value (specifies the width of all items in the toolbar).
Item height ITEM-H attribute value (specifies the height of all items in the toolbar).
MARGIN-X attribute value. Specifies the margin (in pixels) to the left and right of the
Margin-X tool bar items (for horizontal tool bars) or above and below the tool bar items (for vertical
tool bars).
MARGIN-Y attribute value. Specifies the margin (in pixels) above and below the topl bar
Margin-Y items
9 (for horizontal tool bars) or to the left and right of the tool bar items (for vertical too
bars).
Borders:
Left STYLE attribute value. Species whether a border should be displayed
on the left side of the control. This option is not available for dockable tool bars.
To STYLE attribute value. Species whether a border should be displayed
P at the top of the control. This option is not available for dockable tool bars.
Right STYLE attribute value. Species whether a border should be displayed on
9 the right side of the control. This option is not available for dockable tool bars.
Bottom STYLE attribute value. Species whether a border should be displayed at
the bottom of the control. This option is not available for dockable tool bars.
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Tool Bar Control Attributes Subwindow

Dialog Editor

Entry in Attributes

eight

flat

D

)Jo]

ms

Subwindow Represents
The following four attributes decide the tool bar control’s x and y axis position, its i
and its width on the screen.
X - RECTANGLE-X attribute value.
Rectangle: Y - RECTANGLE-Y attribute value.
W - RECTANGLE-W attribute value.
H - RECTANGLE-H attribute value.
Note: the positions are relative to the dialog window.
Style:
Grioper STYLE attribute value. Determines whether a gripper bar is displayed within
PP the tool bar control. Note: the gripper bar does not appear if the tool bar is floated.
Elat STYLE attribute value. Indicates that the tool bar items should be displayed with a
appearance.
. STYLE attribute value. Indicates that the tool bar control can be resized when floated.
Dynamic . . . .
Note: dynamic tool bars cannot contain any child controls.
3-D border STYLE attribute value. If set, the tool bar control’s border (if any) is drawn with a 3
appearance.
State:
Visible VISIBLE attribute value.
Enabled ENABLED attribute value (not for MENU-ITEM-TYPE "Separator").
Dockable DRAGGABLE attribute value. If set, the tool bar control may be docked and/or floated in
its own separate window.
: HAS-TOOLTIP attribute value. If not set, display of the tool tip text (if any) for the t
Tooltips : .
bar items will be suppressed.
HAS-DIL attribute value. If not set, display of the DIL text (if any) for the tool bar ite
Flyby text .
will be suppressed.
OK Save settings and exit the window.
Cancel Exit the window without saving the settings.
Help Provides online help on the attributes window.
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Dialog Boxes

Array

Data Area - Local, Parameter
Data Area - Global

Dialog Compile Error

Events

Import Data Field

Font

Source

Subroutines

Array

» Accessible Using

1. First open the attributes window of a dialog or dialog element by double-clicking on it or by pressing ENTER
or by selecting 'Attributes...” from the dialog or dialog element’s context menu.
2. Then click on the "Array..." push button.

Purpose

Define an array of dialog elements of the same type. This is especially useful for quickly creating a layout for end
user input. An array of dialog elements will be treated as an entity by the dialog editor, that is, you can edit the entire
array (move, resize, etc.). For example, you can create a column of evenly spaced input field controls plus a column
of corresponding text constant controls.

Entries
Entry Function
. . None means there will be no array, one means there will be a row or a column, two means there
Dimensions . : .
will be an array with both an x and a y axis.
Bounds Dialog elements on the first and second axis from occurrence to occurrence.
Spacing Number of pixels between occurrences aligned on the x and y axis.
Mutually exclusive options of how to arrange the dialog elements; the last axis is either the
Arrangement . .
horizontal or the vertical one.

Data Area - Local, Parameter

» Accessible Using

® "Dialog > Parameter Data Area/Local Data Area"; or
e CTRL+ALT+PIL, or (for LDA’s) by selecting 'Local Data Area...’ from the dialog’s context menu.

Purpose

Enter inline data definitions for a dialog. In a parameter data area, you must include all the parameters that you want
to be passed on to the current dialog in an OPEN DIALOG or SEND EVENT statement. In a local data area, you
must include all the user-defined variables or other variables that you want to use in an event handler code section or
a subroutine of the current dialog. Note that the dialog editor automatically generates the data definitions for the
dialog elements.
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Data Area - Global Dialog Editor

The "Using" button opens a dialog box that allows you to include existing inline data definitions.

Data Area - Global

»  Accessible Using

1. "Dialog > Global Data Area"; or
2. CTRL+ALT+G.

Purpose

Select an existing global data area from a list of available global data areas. To select, click on the entry in the list
box. The data area is then displayed in the input field. To select, you can also enter the name of a global data area in
the input field.

To create a new global data area, you use the data area editor.

Dialog Compile Error

Appears When

You check/run/stow a dialog, the compiler finds an error in the dialog’s generated code, and you select "Edit" in the
"Error" dialog box.

Purpose

Describes the error and lists the line of generated code together with the line number. If you press the OK push
button, the section of the dialog appears where the compiler has located the error.

If you have saved your dialog sources in non-enhanced format and the enhanced listing option is enabled, any
Natural error message will contain an incorrect line number. To ensure that you get the correct line number, disable
the enhanced listing option. As under Natural for Windows and Unix/OpenVMS Version 4.1, dialog sources are
always saved in enhanced format, this line number inconsistency does not exist.

» To disable enhanced dialog list mode

® From the "Options" menu, choose "Enhanced dialog list mode".
The menu item no longer has a check mark. This indicates the option is disabled.
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Events

» Accessible Using

Click on the "Events..." push button in an attributes window; or
"Dialog > Event Handlers" for dialog events; or

CTRL+ALT+E or SHIFT+ENTER for dialog events; or

"Control > Event Handlers" for a selected dialog element; or
CTRL+SHIFT+E or SHIFT+ENTER for a selected dialog element.

arwbdPE

Purpose

Enter Natural event handler code for those events that are provided for the dialog or dialog element; also allows you
to enter event handler code for user-defined SEND EVENTS.
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Events Dialog Editor
Entries
Entry Function
This selection box lists the names of the system-provided events, such as the click event; it alsg lists the
Event names of the user-written events that can be triggered by specifying SEND EVENT
Name user-written-event-nam®lease note thaser-written-event-namese limited to 32 characters and that
the option only applies to dialog events.
. Invokes the program editor for the currently displayed event. Before using the program editor the dialog
Editor ; A
box must be closed using the 'OK’ push button.
Rename (Only applies to dialog events). This push button opens a dialog box where you can rename a
user-written event.
New (Only applies to dialog events). This push button opens a dialog box where you can enter the name of a
new, user-written event.
(Only applies to dialog events). This push button opens a message box where you can specify iwhether
Clear you want to delete the code of a system-provided event or the code and the name of a user-wriften
event.
This push button opens a dialog box where you can select a subprogram or a subroutine by chposing an
item from a list of objects or by entering the object name in the input field. Depending on whether it is a
subprogram or a subroutine, you get a display of whether the CALLNAT or the PERFORM stat¢ment
Use will be used. After having selected the subprogram or subroutine, you leave the dialog box by choosing
OK. The subprogram or subroutine will be used by your current event handler code section. At the
position where you left the event handler section, you will find the CALLNAT or PERFORM statement
with the name of the object.
Suppresses an event for which a corresponding SUPPBR&ESHBIamdEVENT attribute exists. The
Suppress . . .
event is also suppressed if you leave the event handler section empty.
:En\;gnt (Only applies to ActiveX control events): Provides information on the parameters of each event
;Egg) Here you enter your Natural code that you want to be triggered when the event occurs.
OK Saves the code (and name) of the event handler section and exits the dialog box.
Cancel |Exits the dialog box without saving the settings.
Help Provides online help.
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Import Data Field

» Accessible Using

e ‘"Insert > Import > Input Field/Selection Box".

Purpose

Create an input field control or a selection box control based on a data field from another Natural object in another
Natural library. The dialog element is created with a linked variable as the source of its STRING attribute value. You
must declare this linked variable in a data area of the dialog.

Entries
Entry Function
Librar Selection box where you can select the library containing the Natural object with the data field pf your
Y I choice.
Type Mutually exclusive options for Natural object types.
Sg[eCt Once you have chosen a library and an object type, all objects with these criteria will be displayed here.
Data Once you have chosen an object from the object list, all data fields defined in this object will be

fields displayed.

Once you have chosen one or several data field(s), you push this button and its content will be

Import imported into your input field control or selection box control.

Cancel Exits the dialog box without saving the settings.

Help Provides online help.

Font

» Accessible Using

1. First open the attributes window of a dialog or dialog element by double-clicking on it or by pressing ENTER.
2. Then click on the "..." push button next to the font selection box.

Purpose

Select a font type, such as "Times New Roman", a font face, such as "bold", and a font size, such as "10". After
selecting your font, a sample is displayed. When you choose OK, a font control is generated and assigned to the
FONT-HANDLE attribute of the dialog element you are currently editing.
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Source

Source

Dialog Editor

» Accessible Using

1. First open the attributes window of a dialog or dialog element by double-clicking on it or by pressing ENTER.
2. Then click on the "..." push button to the left of an attribute entry.

Purpose

Define the source of attribute values, for example for the STRING attribute.

rray is

re-open

I
ged the
can use
ill be

Entry Function
Value Current attribute value; the name of this entry varies depending on the attribute source.
Attribute
Source:
Constant Text string.
Number of the string in the message file. If you have specified an array of dialog elements, tIe
Message filel number of the first string appears here. The number of the string for each occurrence in the
generated in ascending order from the first string number onwards.
When a dialog is opened with an OPEN DIALOG statement, the content of this variable will e
) assigned to the attribute. You can dynamically change the content of this variable in the befa
Variable event handler.
For more information, sedessage Files and Variables as Sources of Attribute Values
Only applicable to input field controls and selection box controls. The input of an end user wi
. automatically be moved to this variable when the dialog element is left. When you have char
Linked . : . . . )
variable content of a linked variable dynamically (during processing of an event handler section), you
the PROCESS GUI statement action REFRESH-LINKS and the refreshed variable content w
displayed in the input field control or selection box control.
M_ Attribute values if there is an array of dialog elements.
Values:
:/r;olllljvelgual Each occurrence in the array will have its individual attribute value.
Repeated All occurrences in the array will have the same attribute value.
single value
OK Saves the settings and exits the dialog box.
Cancel Exits the dialog box without saving the settings.
Help Provides online help.
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Subroutine

Subroutines

» Accessible Using

1. "Dialog > Inline subroutines"; or
2. CTRL+ALT+S.

Purpose

Enter standard sections of Natural code to be used in several event handler sections.

S

Libroutine
ust be

he code

Entries

Entry Function

ﬁ;rt:]rgutme This selection box lists the names of the existing subroutines for the dialog.

Editor Invokes the program editor for the currently displayed subroutine. Before you use the progr,
editor, the dialog box must be closed using the 'OK’ push button.

Rename This push button opens a dialog box where you can rename a subroutine.
This push button opens a dialog box where you can enter the name of a new subroutine. S

New names specified in the dialog editor are limited to 120 characters. The first 32 characters m
unigue.

Delete This push button opens a message box where you can specify whether you want to delete
and the name of a subroutine.

Action: Here you enter your Natural code in free form, that is, without having to specify the DEFINE

' SUBROUTINE and END-SUBROUTINE statements.

OK Saves the code and name of the subroutine and exits the dialog box.

Cancel Exits the dialog box without saving the settings.

Help Provides online help.
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